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Introduction
The goal of segmentation is to partition an image into regions, or objects, that are homogeneous with respect to one or more
characteristics or features. Segmentation is a critically important tool for the processing of image data and is often the precursor to other
applications such as measurement, visualization, surface-based registration and surface extraction.
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Object Maps
Analyze uses a file called an object map

Object Map Segmentation vs. Grayscale Segmentation

to partition image data into groups of
voxels within a segmentation component
map. After creation of the object map
through segmentation, it can be used to
drive visualization, registration, surface
generation and statistical analysis.
The object map is an associated volume
with the same dimensions as the image
data. Each voxel of the object map
contains an 8-bit value which encodes it
as belonging to 1 of 256 total possible
objects. Every voxel in the data set
is initially assigned to the first object
(Original), leaving 255 additional objects
that can be used for 2D region or 3D
volume of interest definition.
Object maps are loaded separately
from the image data to which they are
associated using the File > Load Object

Grayscale segmentation destroys all voxels that are not part of
the object of interest.

Object maps preserve the original data by assigning the
segmented voxels to objects.

Map option in each functional module.
When the object map is loaded, the
objects defined in it are overlaid on the
image data.
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Segment Module Interface
The Segment Module interface is
divided into the following areas:
[1] Menu, [2] Segmentation Options,
[3] Display Controls, [4] Tools,
[5] Object Control Window, [6]
Orthogonal Image Display, and [7]
Rendering Window.
Each of the Segment Module
Interface areas are now described:
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Menu
The Menu provides access to the File, Options and Help menus.
File
The File menu allows users to load and save object maps for the loaded data set. The File options include:
Input/Output Ports: Displays a Volume area at the bottom of the Segment module window. This area facilitates the dragging and dropping of
image data into the module and the loading of a related image data set, see Dual Input Segmentation for additional information.
Load Object Map: When selected opens a Load Object Map window allowing users to navigate to, select and load an object map file. The
following options are available:
•

Current Directory: Takes user to the current directory, the current directory is set by right-clicking in the main Analyze 14.0 window and
then choosing Current Directory from the menu. See section 1. Analyze Basics for additional information.

•

Workspace Directory: Takes user to the current Workspace directory.

•

Home Directory: Takes user to the user’s Home directory.

•

Cancel Load: Cancels the load of the object map.
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Menu (continued)
Save Object Map: When selected opens
a Save Object Map window allowing users
to navigate to name the object map and
select a location to save the object map
file.
Save Object Map As: Allows users to
save a copy of the current object map
without overwriting the original object
map file.
Reset Object Map: Resets the current
loaded object map, deleting all defined
objects. When this option is selected a
prompt will be returned asking you to
confirm the reset. Select ‘Yes’ to continue
or ‘No’ to cancel.
If the object map has not been saved or
changes to an object map have not been
saved when the Rest Object Map option is
selected an Object Map Changed prompt
will be returned providing the opportunity
to save the object map.
Exit: Closes the module
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Menu (continued)
Other
The other menu provides access to additional module options and configuration of the tools area.
Options: When selected opens the Options menu providing access to Module configuration options, including:
•

Intensities Linked: Allows users to enable or disable linked intensity adjustment. When linked any adjustment an images intensity display
will be applied to all grayscale slices displayed. When disabled image intensities can be adjusted individually.

•

Fast Object Rendering: Enables/Disabled Fast Object Rendering.

•

Show Cursor Coordinates: Allows users to Enable/Disable the display of the linked cursor coordinates and voxel grayscale value displayed
in the lower left-hand corner of the display window.

•

Auto Note Update: Allows the Auto Note Update option to be enabled or disabled.

•

Auto Cursor Link: Allows the Auto Cursor Link option to be enabled or disabled.

•

Remember Layout: When enabled the module will remember changes made to the layout and will open with this layout in the future. When
disabled the module will open with the default layout.

•

Threads: Allows users to specify the number of threads used in a multi-threaded rendering process. By default, the number of threads is set
to the number of processors on the system.
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Menu (continued)
Powerbar Editor
When selected opens the PowerBar editor
allowing users to add additional shortcut
buttons to the tools area of the Segment
window. Add or remove the following
shortcut buttons form the tools area: 1)
Exit, 2) Options, 3) Input/Output, 4) Load
Object Map, 5) PowerBar Editor, 6) Reset
Object Map, 7) Save Object Map As, 8)
Save Object Map, 9) Set Note Stat, 10)
Toggle Cursor Link, 11) Toggle Region
Display.
Help
The Help menu provides users with quick
access to help resources including:
•

About: View version, system and
environment information.

•

Users Guide: Opens the Analyze 14.0
User’s Guide.

•

Get Help: Opens the AnalyzeDirect
Support Page.
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Display Controls
The Display Control tools allow users
to control and customize the layout
of the Segment display area. Some of

Control Layout

these control options are unique to

Toggle Rendering

Segment.

Toggle Oblique
Toggle All Orientations

Control Layout
This option allows users to control the
layout of the display. Choose from
Axial as Primary, Coronal as Primary,
Sagittal as Primary, Render as Primary
or No Primary image.

No Primary Image: This is the default
selection.
This option displays the rendering
and three orthogonal views in four
equally sized windows.
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Display Controls (continued)
Axial as Primary: Focuses the
display on the axial image. The
coronal, sagittal and rendering
windows are displayed below the
axial window.

Coronal as Primary: Focuses the
display on the coronal image. The
axial, sagittal and rendering windows
are displayed below the coronal
window.
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Display Controls (continued)
Sagittal as Primary: Focuses the
display on the sagittal image. The axial,
coronal and rendering windows are
displayed below the sagittal window.

Render as Primary: Focuses the
display on the rendering. The axial,
coronal and sagittal windows are
displayed below the rendering.
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Display Controls (continued)
Toggle Rendering
The Toggle Rendering options allows
users to switch the Render window on
[1] and off [2].
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Display Controls (continued)
Toggle Oblique
The Toggle Oblique option allows
users to switch the oblique display
window [1] on and off.

The oblique window provides users
with the ability to create any arbitrary
oblique plane on the fly, using the
control tools [2] in the oblique window.
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Display Controls (continued)
The oblique image can also be
generated using the blue oblique
reference line that appears in all of the
other enabled windows [3].
When the oblique image is enabled,
an additional option becomes
available: Toggle Perpendicular [4].
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Display Controls (continued)
Toggle Perpendicular
The Toggle Perpendicular window
provides an oblique control window
for each orientation [1].

The control tools [2] can be used
to manipulate each orientation to
aid users with the generation of the
desired oblique plane.
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Display Controls (continued)
When enabled, the perpendicular
displays can be viewed with the
Rendering toggled on [3]. While
this option is up to the user, some
users find the oblique reference
lines displayed on the 3D rendering
helpful when manipulating the
oblique plane in 2D.

Users may also find it useful to switch
off the linked cursor tool [4] when using
the oblique reference lines.
For more information about creating
oblique planes, refer to the Apply
Matrix exercise in the Transform
section.
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Display Controls (continued)
Toggle All Orientations
The Toggle All Orientations option
allows users to switch between the
display of the axial, coronal and
sagittal [1] windows to a single image
window [2].
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Display Controls (continued)
When the rendering is enabled, the 3D
rendering will also be displayed [3].

When display is toggled to single
display mode, additional display
options are enabled [4].
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Display Controls (continued)
The additional options allow users to
display the image before [5] and after
[6] the current slice. To display another
orientation, click on the Orient text
[7] to cycle through the orthogonal
orientation displays.
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Tools
The Tools options in the top right
hand corner of the Segment Module

Cursor Link

Interface, provide access to the

Toggle Region Display

Cursor Link, Toggle Region Display
and the Set Note State tools.

Set Note State

Cursor Link
The cursor link allows users to
interactively navigate through the
image data. The tool can be controlled

from any of the 2D orientations or
from the 3D rendering. Moving the
tool will interactively update the
corresponding slice displays.
The linked cursor can be enabled
or disabled using the Toggle Cursor
Link button.
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Tools (continued)
Toggle Region Display
Users have the option to change
the display of objects on the 2D
slices. Users can cycle through the
various object display options using

the Toggle Region Display button
or using the t key.
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Tools (continued)
There are four object display options:
Filled Regions

Edges

Filled Regions with Edges

Off
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Tools (continued)
2D Object Opacity Display: It is
possible to change object color
alpha blend for the display of objects
on the 2D slice data for the filled
regions and filled regions with edges
object display options. Adjusting the
alpha blend allows users to visualize
underlaying grayscale data while still
seeing which voxels are assigned to
objects.
To adjust the alpha blend right-click
on any of the 2D slices displays and
then choose the Set Object Opacity
[1] option to enable it.
An Opacity slide will appear below
the slice display window [2] allowing
users to adjust the alpha blend of
the objects on the image data. The
default opacity value is 50%.
Use the slider to reduce the object
opacity value [3] and review the effect
[4].
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Tools (continued)
Notes
The Notes tool in Analyze allows
users to annotate image data in 2D
or 3D. Notes will be associated with
the data set and can be loaded into
other modules. Notes can be hidden
or deleted at any time.

Shows notes (default).

Allows users to make and edit notes.

Hides notes.
To annotate a data set using notes
click on the Notes button in the
toolbar (note that the Edit mode will
be activated.) Click on any 2D slice or
the 3D rendering to create a note.
Analyze 14.0 User’s Guide

© AnalyzeDirect, Inc.

295

SEGMENT > SEGMENT MODULE INTERFACE

Object Controls Window
The Object Controls window allows users to
add objects to the current object map. It also
allows users to edit object properties. The
Object Controls window provides users with the
following object control options, functions, and
productivity tools:
Add Object
The Add Object button [1] allows users to add
new objects to the object map. Objects are
show in the object list [2].
Name
The Name field [3] in the object attributes
area allows users to modify the assigned
object name to something applicable for the
segmented object.
Color
Object color can be updated by entering the color name (e.g. Gray) or the hex color code (e.g. #808080) in the Color field. [4]
Object colors can also be interactively selected using an object color palette. To open the Color palette, click on the palette icon [5] next to
the Color field or the colored square next to the object name in the object list.
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Object Controls Window (continued)
The Color selection palette [6] will open, select
a basic color or use the color selector to choose
a color. Color HSL and RGB values can also be
input.
Display
The Display attribute for an object controls
if the object is visible or not on the 2D slice
displays and 3D rendering. To disable and
enable the display of an object use the Display
checkbox [7] in the object attribute are or click
the screen icon next [8] to the object in the
object list.
Object Lock
Object locking provides the ability to lock
objects preventing the voxels assigned to the
locked object from being edited. This is a
powerful tool to aide segmentation, as locking an object protects objects from being written over. When an object is locked, the boundary
of the object acts as a limit. This can be leveraged to help with the segmentation of objects that are spatially connected. However, some
semi-automatic tools do not observe locked objects. Before such a tool is used, a dialog box will appear notifying the user of this.
Objects can be locked and unlocked by checking the Locked checkbox [9] in the object attribute area or by clicking the lock icon [10] for the
object in the object list.
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Object Controls Window (continued)
Opacity
The Opacity option [11] is only available
when the Transparency option is enabled.
To enable the option right-click on the
rendering and choosing Transparency
form the menu. Adjusting object opacity
levels allows users to enhance the
rendered display of objects. Object
opacity can be manipulated by using the
opacity slider or by entering a value in
the text field.
Delete
The delete button [12] allows users to
remove objects form the object map.
Voxels assigned to an object that is
deleted are reassigned back to the
Original object and the object is removed
from the object list.
Right Mouse Menus
There are several right mouse menu options in the object controls window, and these menus are accessible by right-clicking in the object list
[13], the object attribute area [14], and the area around the Add Object button. [15]
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Object Controls Window (continued)
Object List Right Mouse Menu
Right click in the object list area to access
additional object functionality from the
right mouse context menu. These options
include:
Control By: The Control By option
allows users to set the control of object
attributes by objects or by attribute.
When set to Object users can modify
all object attributes for a single object.
When set to Attribute users can modify
the selected attribute for all objects:
•

Objects: Objects is the default control
by option, displaying a list of objects.
Attributes for each object can be
edited in the object attribute area for
each object.

•

Attributes: When the Attributes option is selected the object list area updates providing an attribute drop down menu [16]. Users can
select any of the object attributes to enable or disable for all the objects in the object map [17]. The attribute options include; Display,
Lock, Name, Color, Shades, Neighbors Used, and Opacity. Controlling by Attribute is extremely useful when you need to modify
attribute values for many objects. Right-clicking in the object area provides access to additional selection options to enable or disable
attributes including All, None, and Invert.
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Object Controls Window (continued)
Remove Unused: allows users to quickly
delete any object in the object list that
doesn’t have a voxel assigned to it. A
helpful option for object map clean-up.
Reorder Objects: allows users to reorder
objects in the object list. When selected
a Reorder Objects window opens [18].
Objects can be moved up or down in
the object list using the arrow keys next
to the object [19]. Right-clicking on an
object allows you to move the object to
the top or bottom of the object list [20].
To apply changes in object order click the
Re-order button [21].
Reassign Objects: Selecting the
reassign object option will open the
Reassign Object(s) window enabling the
reassignment of one or many objects to
another. Select the object to reassign
from the ‘Reassign From’ list [23] then set
the object to reassign to from the ‘To’ drop down list. [24] Check or uncheck the Remove Object After Reassignment check box [25] and
then click Apply. [26] All voxels assigned to the objects selected in the ‘Reassign From’ list will be assigned to the object in the ‘To’ list.
Recalc Objects: When this option is selected the module calculates and sets the minimum enclosing 3-D region for each object.
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Object Controls Window (continued)
Load Objects: allows users to load objects from another object map into the current
object map. For example, electrodes segmented from a CT data set could be loaded
onto a brain object in a co-registered MRI data set. To use, right-click on the object list
area and then choose Load Objects from the menu. In the window returned navigate
to and select the object map that contains the object(s) you wish to load. Once select a
Load Object(s) window [27] will open. Check the objects you wish to load [28] and then
click Load Selected [29].
Please note, loaded objects will overwrite voxels assigned to other objects so consider
the order that objects are loaded. For example, loading a hippocampus object into
an object map that contains the whole brain would work fine, however, loading the
whole brain into an object map that contains the hippocampus would not work, as the
hippocampus object would be overwrote by the brain object.
Load Binary: allows users to create objects using a binary image. For example, electrodes segmented from a CT
data set saved to the workspace as a binary image could be loaded onto a brain object in a co-registered MRI
data set. The following options are available:
o

Workspace: Select the workspace that contains the binary image to load.

o

File: Select the binary image file.

o

Object: Choose the object to create from the binary image input.

To use, right-click on the object list area and then choose Load Binary from the menu. In the Load Binary window
returned use the Workspace menu option to select the workspace that contains the binary image. Next use the
File option to select the binary image from the workspace. Finally, use the Object drop-down menu to set the
object the binary image will create, by default the option is set to ***New***, however, any object in the object
map can be selected. Finally, click Load Binary.
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Object Controls Window (continued)
Save Binary: allows users to save any object in
the object map out to the selected workspace
as a binary image, the voxels part of the object
will be saved as 1’s while every other voxel will
be saved as a zero. The following options are
available:
o

Object: Chose the object to save.

o

Workspace: Select the workspace to save

the binary image to.
o

File: Name the file.

o

Save Binary: Initiates the save process.

Save Greyscale: allows users to save any object
in the object map out to the selected workspace
as a grayscale image, with all voxels not part of
the object removed from the image (set to the
background). The following options are available:
o

Object: Chose the object to save.

o

Workspace: Select the workspace to save

the greyscale image to.
o

File: Name the file.

o

Save Greyscale: Initiates the save process.
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Object Controls Window (continued)
Apply Edits: allows users to change the voxel grayscale values in the image for any object in the
object list, including the original object. To use, right-click on the object list area and then choose
Apply Edits from the menu. In the Apply Object Edits to Volume window returned [30] select the
object(s) to edit [31] and then use the drop-down menu to choose the type of edit to apply. The
following options are available:
•

Set to Value: Allows users to select a single greyscale value that all voxels represented by the
object will be assigned to.

•

Intensity Scale Values: Provides users with the ability to the range of the grayscale values by
adjusting the minimum and maximum values.

•

Random Value: Assigns voxel values to a random value. The Random value maximum and
minimum range defaults to volumes maximum and minimum, but these values can be edited by
the user.

•

Gaussian Value: Assigns voxel values within the object to be assigned to a Gaussian Value. Mu
and Sigma values are calculated automatically, but can be updated by the user.

Assign the desired value(s). Choose to Apply the edits to the Loaded Volume or a Copy of the
Loaded Volume (recommended) and then click the Apply Edits to Volume button [32] to update
the data set.
Load Surface: Allows users to load related .stl or .pogo surface files for the data set.
Extract Surface: The Extract Surface option allows users to generate and save surface files from
objects. For instructions on how to use this option please refer to the Generating Surface Files
from Objects section of this guide.
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Object Controls Window (continued)
The Object Attribute Area Right Mouse Menu
Right click in the object attribute area to access additional object functionality from the right
mouse context menu. These options include:
Control By: The Control By option allows users to set the control of object attributes by objects or by attribute. For a full description please
see the Control By section in the Object List Right Mouse Menu Options section above.
Neighbors: The Neighbors option allows users to specify which voxels are used to calculate the gradient for image rendering. Changing the
neighbors option can help improve the display of rendered objects especially with anisotropic data sets or with objects loaded from related
data sets. The following options define the neighbors used:
•

All: Specifies that all voxels, no matter which object they belong to are used.

•

Object w/Gradient: The object with gradient specifies that only the grayscale values of neighboring voxels which belong to the same
objects are used.

•

Object wo/Gradient: The object without gradient specifies that only neighboring voxels which belong to the same object are used. The
grayscale value of the voxels are ignored, with gradient computations applied to the object map itself (binary surface rendering).

•

Object Smoothed: This option is similar to object without gradient option, however, instead of using only the neighboring voxels
belonging to the same object to calculate the shading, the neighboring voxels within a5x5x5 region around the voxels of interest are
used. A weighting factor is applied so that the closest neighbors have twice the contribution as those twice as far away.

Shades: The Shades options allows users to set the number of shades used for the object. Users can choose from; 1, 16, 32, 50, 64, and 256.
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Object Controls Window (continued)
The Add Object Area Right Mouse Menu
Right click in the Add Object area provides access to the Templates option. The Templates option allows users to create object templates
for object maps, this option is especially useful when users create the same object maps containing the same objects for multiple volumes.
It is also helpful for object maps that contain may objects. To use this option, create a list of objects specifying object names, colors, and
any other attributes and then right-click and choose Templates > Save Templates. Choose to save for the Current User or All Users and then
name the template. Click Save.

To load an object template right click in the Add Object area and then select the template. User specific templates (Current User) are shown
at the top of the window while system templates (All Users) are shown in the middle. Once the template is selected the objects specified in
the template will be loaded to the object list. Note that these are just empty objects, templates will not save any kind of segmented object
region.
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Orthogonal Image Display
The orthogonal slice display windows provide an interactive 2D review tool of the slice data in the axial, coronal and sagittal planes. For
more information about the slice display windows, refer to the Display section of The Analyze User’s Guide.
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Renedering Window
The Rendering Window provides an interactive 3D display of the segmented image data. For more information about the render window,
refer to the Display section of The Analyze User’s Guide.
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Segmentation Tools
The segmentation options are provided in five tabs:
• Edge Strength
• Walls
• Subregion
• Semi-Automatic
• Manual
These five tabs provide access to all the segmentation tools in Segment. The segmentation tools within each tab will now be described.
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Edge Strength
The Edge Strength option allows users
to mask the input data with a set of
enhanced gradients that act as limits
aiding in the segmentation of structures.
Edge strength works by applying a 3
X 3 X 3 Sobel filter to the image data,
which can be interactively adjusted using
the Edge Strength Threshold slider. All
voxels with gradient values less than or
equal to the selected threshold value are
displayed with a definable edge color
and form boundaries around structures.
The boundaries act as limits, restricting
semi-automatic segmentation operations.
The following controls are available:
Use Edge Strength to Enhance Segmentation: When this option is checked the Edge Strength option is enabled for the image data, a 3
by 3 by 3 Sobel filter is applied to the volume and the Edge Strength Threshold slider and additional options are enabled.
Edge Strength Threshold: This slicer defines the upper threshold value for the Sobel filtered gradient volume. When the left mouse button
is used to drag the slider, all of the voxels with gradient values less than or equal to the threshold value are highlighted. Semi-automated
segmentation algorithms are applied to the voxels within the threshold range.
Edge Color and Edge Opacity: Allows users to specify the color and adjust the opacity display of the edge overlay on the image data.
Show Edges on All Tabs (when active): maintains the display of the edges on the image data when moving to different segment tabs.
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Using Edge Strength
First we will attempt to segment the
heart from this CT data set without
using edge strength.
To follow along, download the data
set CT_Heart from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Select Semi-Automatic [1], and
choose Region Grow [2].
• Click on the image data to set a
seed point [3 ]. The seed point
should be in the object you
would like to isolate.
• Set the threshold Min/Max values
to define the object [4] and click
Connect Object [5].
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Using Edge Strength (continued)
• The results of the region grow
are shown below.
• The segmented object is shown
overlaid on the 2D slice data
[6] and a 3D representation [7]
is displayed.
Note that both the heart and the spine
have been assigned to Object_2 [8].
• Click Undo.
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Using Edge Strength (continued)
Now we will repeat this segmentation
using edge strength to separate the
heart from the rest of the data set.
• Select Edge Strength [9] and
check Use Edge Strength to
Enhance Segmentation [10].
• Set the Edge Strength Threshold
to 90. Note that this value will
be different for each data set. In
general, adjust the edge strength
using the slider [11] until you
find a suitable value. The edges
will interactively update on the
data set. Use the edge display
to determine the suitable edge
strength value.
• Optionally, change the color of
the edge by entering the desired
color in the text field or by using
the color selector [12].
• When performing the
segmentation, leave the Show
Edges checkbox [13] selected.
If required, reduce the Edge
Opacity using the slider [14].
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Using Edge Strength (continued)
The edges detected on this data set using the Edge Strength algorithm with an edge strength threshold of 90 are shown overlaid on
the data below.
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Using Edge Strength (continued)
• Repeat the segmentation. Select
Semi-Automatic, then choose
Region Grow.
• Click on the image data to set
a seed point. The seed point
should be in the object you
would like to isolate.
• The Threshold Min/Max values
should still be set to the previous
values. If not, reset them to
define the object and then click
Connect Object [15].
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Using Edge Strength (continued)
Note that this time, only the heart was segmented. The Edge Strength technique prevented the region grow algorithm from including the
spine in the object. Further segmentation can now be achieved with or without Edge Strength enabled. Select File > Save Object Map to
save your work.
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Walls
Segmenting structures of interest that are connected to surrounding anatomy with similar grayscale values can be challenging. The
Walls option provides tools to create adaptable 3D limits to help make this process easier for the user. The Walls tool is useful for many
segmentation applications, particularly isolating the cerebellum from the rest of the brain parenchyma or limiting the boundaries of a region
grow operation to isolate blood pools from cardiac data.
The Walls option allows users to
define traces which are used to limit
the extent of an object. Separate
walls can be created in each
orientation, the wall defined in one
orientation is not reflected in the
other orientations. Traces defined
on slices are linearly interpolated
within each orientation reducing
user interaction time, so that a trace
defined on slice 10 and a trace
defined on slice 50 are automatically
interpolated between so the user
doesn’t have to define the wall on
each slice between. The interpolated
traces are designated by a dashed
green line, while the user defined
traces appear as a dashed red line.
Walls are used with the Threshold Volume, Region Grow, Connected Components, Object Extractor and Object Separator Semi-Automatic
tools. Walls can also be used in conjunction with the Edge Strength and Subregion tools.
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Walls Tab Options
The Walls tab provide the following
option:
Define Walls to Limit SemiAutomated Operations: When
checked enables wall definition
options allowing users to define walls
on the image data.
Wall Type: Allows users to select
the wall definition mode, the options
include:
•

Line: The line option allows users
to define a straight-line wall on
the image data.

•

Trace: Allows user to define a
freehand wall on the image data

•

Spline: The Spline option allows
users to define a curved wall.
Splines are flexible curve traces
with movable control points that
are useful for creating smooth
walls.
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Walls Tab Options (continued)
•

Smart Edge: The smart edge
option detects regions of high
rate of change of voxel intensity
(gradient) that represent edges,
smart edge snaps to the edges of
these regions.

•

Sensitivity: The sensitivity of
the smart edge can be adjusted
using the slider or the mouse
scroll wheel. The lower the value
the less sensitive the tool is,
the higher the value the more
sensitive the tool is.

Extend Wall(s): Specifies if the wall
is extended beyond the first and last
user defined wall in each orientation.
Reset Wall(s): Allows the user to
reset the defined walls in any or all
orientations.
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Using Walls
Here we will use the Walls
functionality to segment the
cerebellum from the rest of the brain
parenchyma in a head MRI dataset.
To follow along, download the data
set EGV_MRI from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Select Walls [1] and check Define
Walls to Limit Semi-Automated
Operations [2].
• Set the Wall Type to Spline
[3].
• Set the primary display to
Sagittal [4].
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Using Walls (continued)
• Navigate through the sagittal
slices to find the first slice that
includes tissue belonging to
the cerebellum. Draw a wall
separating the cerebellum from
the cerebrum on this slice.
• To draw a wall using the spline
tool, left-click to set spline
points which will connect into a
smooth line. Double-click when
defining the last spline point to
set the spline [5].
• The spline points can be adjusted
by left-clicking and dragging.
Right-clicking on a spline point
allows you to delete it or make
other changes to the spline such as
closing the spline or deleting the
entire spline.
• Move forward through the
sagittal slices and adjust the wall
as required [6].
• The Wall can also be redrawn if
necessary.

Analyze 14.0 User’s Guide

© AnalyzeDirect, Inc.

SEGMENT > WALLS

320

Using Walls (continued)
• Once the cerebellum is no
longer well defined by the wall,
redefine the wall on that slice.
The wall will be interpolated
between all slices on which it is
defined. When finished, scroll
through the slices to ensure that
the cerebellum is well defined
by the wall.
Note that walls can be set in multiple
orientations. This is helpful when
trying to isolate structures connected
to several surrounding structures in all
orientations. For example, it can be
used when isolating the heart from
the lungs, spine, sternum, etc. It can
also be useful to define walls in the
sagittal and coronal orientations to
better segment the cerebellum.
• Continue to define walls around
the cerebellum in the sagittal
orientation [7], [8].
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Using Walls (continued)
• Once the cerebellum boundary
is defined in three dimensions
by the wall, select the SemiAutomatic tab [9] and choose
Object Extractor [10].
• Click in the cerebellum on a
sagittal slice to set a seed point
[11].
• Adjust the maximum and
minimum threshold values [12]
until the auto trace defines the
object [13].
Note that while the entire brain will
be defined, the walls will prevent the
whole brain from being segmented
and will confine the segmentation to
the cerebellum.
• Click Extract Object [14].

Analyze 14.0 User’s Guide

© AnalyzeDirect, Inc.

SEGMENT > WALLS

322

Using Walls (continued)
• The cerebellum will be isolated and displayed in 3D.
• Once segmentation is complete, the structure will be rendered [15] and overlaid on the slice data [16].
• Save your work by selecting File > Save Object Map.
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Subregion
Subregion allows users to limit segmentation to a specific user-defined region. This tool is particularly useful when segmenting a structure of
interest, such as the hippocampus, without having to crop the original image data.
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Subregion Options
Subregion can be used with the
Threshold Volume, Region Grow,
Connected Components, Object
Extractor and Object Separator
Semi-Automatic tools. Subregion can
also be used in conjunction with the
Edge Strength and Wall tools.
Restrict Segmentation with a
Subregion: When checked enables
subregion restriction of semiautomatic and manual segmentation
tools. The following options are
available:
•

Segment Inside the Specified
Subregion: Allows users to
segment within the specified
subregion.

•

Segment Outside the Specified
Subregion: Allows users to
segment outside the specified
subregion.
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Subregion Options (continued)
•

X Slider: Allows users to define the extent
of the subregion in the X orientation.

•

Y Slider: Allows users to define the extent
of the subregion in the Y orientation.

•

Z Slider: Allows users to define the extent
of the subregion in the Z orientation.

•

Shade Restricted Area: Allows users to
switch on shading [1] for the restricted area
or switch off shading [2] for the restricted
area.

•

Shade Color: Allows users to change the
color of the restricted area [3] by typing a
color in the color field area or by selecting
a color using the color section option.

•

Segment Outside the Specified Subregion:
Allows users to segment outside the
specified subregion.

•

Shade Color: Allows users to change the
color of the restricted area [3] by typing a
color in the color field area or by selecting
a color using the color section option.
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Setting a Subregion
Here we will set a Subregion to
protect and limit the region when
segmenting with other tools.
To follow along, download the data
set EGV_MRI from
analyzedirect.com/data and load into
Analyze using Input/Output.

• Select the data set and open
Segment.
• Select Subregion [1], and check
the Restrict Segmentation with a
Subregion checkbox [2].
• Choose to Segment Inside
(default) or Outside the
Subregion [3]
• Use the X, Y, Z sliders [4] or
the yellow control points [5]
to specify the Subregion in all
orientations.
• The area in red will be protected
as you move to the SemiAutomatic or Manual tools to
segment regions of interest.
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Semi-Automatic Tools
The Semi-Automatic tab provides access to many useful tools for interactive, efficient segmentation of objects. These tools include simple
segmentation options, such as threshold, to more advanced, semi-automated techniques like object extraction and object separation. The
segmentation tools available also include those that use 3D spatial connectivity and include region growing and connected components.
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Threshold Volume
Threshold segmentation allows a range of voxels from the input volume to be assigned to an object. All voxels greater than or equal to the
threshold minimum and less than or equal to the threshold maximum are assigned to the object.
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Threshold Volume Options
Threshold Slider: The Threshold double-ended slider bar allows users to
specify a range of threshold values using the minimum and maximum ends
of the threshold slider. Selecting the minimum end of the slider [1] and
moving it to the right will increase the minimum threshold value, moving it
to the left will decrease the minimum value. Selecting the maximum side of
the slider [2] and moving it to the left will decrease the maximum threshold
value, moving the slider to the right will increase the maximum value. Voxel
with values outside the range are ignored and not include as part of the
current object.

When adjusting the minimum or
maximum threshold range [3] an
interactive preview showing the
range of selected voxels will be
displayed overlaid on the grayscale
data [4], a 3D display of the voxels
will also be displayed in the render
window. [5] The color of the
previewed voxels will match the color
of the object you currently have
selected. [6]
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Threshold Volume Options (continued)
Holding the Alt key while dragging either the minimum or maximum end of the slider
allows for smaller adjustment of the value allowing users to fine tune selections. Clicking in
the trough to either side of the minimum or maximum end of the slider [7] will advance the
value by 1. Shift-click will decrease the value by 1.
Min and Max: The minimum and maximum input field allows users to manually enter the
minimum or maximum threshold value. There are also arrow up and down buttons the
right of the input field to increase or decrease the currently value by 1.
Threshold Rendering: This option allows users to disable and enable to 3D preview of
the selected voxel range. It is recommended to disable this option by unchecking the
checkbox when working with large data sets.
Threshold Object: Assigns the voxels in the selected range to the current object.

Right click options: Right clicking on the Threshold
slider provides users with access to the following
options:
Presets: The Presets option allows users to define
threshold values for specific structures or objects of
interest. This is particularly useful for those users who
routinely segment the same structures from their
image data.
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Threshold Volume Options (continued)
Right click options (continued)
Presets (continued): When the Edit Presets Thresholds
window opens, the following options are available:
•

Name: Allows users to enter the name for preset

•

Min: Enter the minimum threshold value for the preset

•

Max: Enter the maximum threshold value for the preset

•

Depend Type: Allows users to set dependencies for
presets. This option allows users to set multiple presets
but only the presets that that meet the dependencies
requirements are displayed for the current data. In the
example screenshot two sets of segmentation presets
have been defined. The first three presets are for a dental segmentation application. The second three presets are for a muscle
segmentation application. As the first three presets Depend Type is set to Any these presets will be available for any data set loaded
into the Segment module. However, the latter three presets have a depend type set to Volume Dimension and the Dependency set
to a volume size of 450 by 450 by 224, these presets will only be available for data sets loaded into Segment of this size. The following
Depend Types are available:
Module: Defaults can be set for specific modules, for example presents to segment image data can be set to only appear when the data
is opened with Segment, presents for rendering set to appear only when data is opened with Display.
Volume Name: The preset will only display if the volume name meets dependency criteria.
Volume Data Type: The preset will only display if the volume data type meets the dependency criteria.
Volume Dimensions: The preset will only display if the volume data type meets the dependency criteria.
Any: Default option. The preset will be displayed.
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Threshold Volume Options (continued)
Right click options (continued)
Presets (continued):
•

Dependencies: Allows users to specify the dependency criteria for the
selected depend type.

•

Action: Allows users to Add or Remove presets.

•

Order: Allows users to change the order of hold the presets are listed. As a
general rule of thumb presets should be listed in the order they are used for
segmentation.

To define a set of presets do the following:
Right-click on the Threshold slider and choose
Presets.
In the Presets window set the preset name, next
enter the min and max threshold values, finally set
a Depend Type and Dependency if desired. Click
Add and either enter the next Preset or choose
Save.
Once Presets are established, they can be accessed
by simply right-clicking on the Threshold slider and
choosing Presets and then the Present name.
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Threshold Volume Options (continued)
Right click options (continued)
Auto Thresholds: The auto thresholds option
allows users to compute up to 6 automatically
computed threshold to specify the number of
automatic thresholds computed.  Selecting a
threshold value will set the minimum threshold to
that value.
Show/Hide Histogram: When selected, calculates
and displays the volume histogram below the
Threshold Volume options.
When the threshold minimum and maximum values
are adjusted the voxels within the selected range
display as green on the histogram while the voxels
out of range are displayed in red. Adjusting the
scale bar to the left side of the histogram display
will increase or decrease the scale the histogram.
Right clicking on the histogram allows users to auto
compute up to 8 threshold values for the image
data. The thresholds are displayed as triangular
buttons at the bottom of the histogram display,
selecting a triangle will set the minimum threshold
value.
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Threshold Volume Segmentation
Here we will use Threshold Volume
to create a new object in a dataset.
To follow along, download the data
set CT_Liver from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Select Semi-Automatic [1] and
choose Threshold Volume. [2].
• Use the Threshold slider [3] to
adjust the voxel intensity range,
so that the soft tissue is displayed
in the binary mask preview. This
data set is scaled to Hounsfield
Units (HU), so the grayscale
intensities represent HU. This
may be used to isolate tissue with
a known HU range [4].
• Click Threshold Object [5] to
assign all selected voxels to the
current object.
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Threshold Volume Segmentation (continued)
• Rename the object, [6] then change the color [7].
• Right-click on the rendering and select Transparency [8].
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Threshold Volume Segmentation (continued)
• Add a new object [9].
• Update the name [10] and color
[11].
• Adjust the threshold range [12]
so that the bone is displayed in
the binary preview, then click
Threshold Object [13].
• Note that the rendering [14] will
update to display both objects.
The bone is now fixed to visible,
as the rendering transparency is
enabled [8].
• Select File > Save Object Map to
save your work.
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Region Grow
Whereas threshold-based segmentation applies globally to all voxels in the volume, region growing can be used to limit the segmentation to
voxels that are connected to a user-defined seed point which fall within a specified threshold range.
To enable the Region Grow options, first a seed point must be set on the structure you wish to isolate [1]. Note, multiple seeds can be
selected to facilitate the simultaneous segmentation of multiple objects as long as the objects have the same threshold properties, for
example multiple disconnected bones.
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Region Grow Options
When the seed is set the following options become available:
Threshold slider: The Threshold double-ended slider bar allows users to specify a range
of threshold values using the minimum and maximum ends of the threshold slider. For a full
description of the threshold slider please refer to the Threshold Volume section.
Min and Max: The minimum and maximum input field allows users to manually enter the
minimum or maximum threshold value. There are also arrow up and down buttons the right of
the input fields to increase or decrease the currently value by 1.
Threshold Rendering: Allows users to disable and enable to 3D preview of the selected voxel
range. Disable this option by unchecking the checkbox when working with large data sets.
Connect Type: Determines if the connection type will be 3D or 2D.
3-D: Region grow will be applied to the (3D) volume.
2-D: Region grow will be limited to the current (2D) slice.
Neighbors: Allows users to select the number of neighboring voxels during the connection
process. The options available depend on the connect type. For 3D, users can choose
6-connected or 26-connected. For 2D, 4-connected or 8-connected can be selected.
•

3D Neighbor options:
6-connected: Specifies that only 3-D neighbors are checked for connectivity during the
region growing process. [1]
26-connected: Specifies that the entire 26-voxel neighborhood is checked for connectivity
during the region growing process. [2]
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Region Grow Options (continued)
•

2D Neighbor options:
4-connected: Specifies that only 2-D neighbors are checked for connectivity during the
region growing process. [3]
8-connected: Specifies that the entire 8-voxel neighborhood is checked for connectivity
during the region growing process. [4]

Reset Seeds: Resets the user defined seed(s). Seeds can also be deleted by right clicking on
the seed and then selecting delete.
Connect Object: Initiates the connection process.
Threshold Slider right click options: Right clicking on the Threshold slider provides
users with access to the following additional options; Presets, Auto Threshold, Show/Hide
Histogram. For more information please refer to the Threshold Slider right click options in the
Threshold Volume section.
Seed point right click options: Right clicking on a seed point provides the following options:
•

Style: The style options allows users to change the of the seed point. Select from Dot,
Crosshair (default), Arrow, and Diamond.

•

Label: The label options allows user to enable and disable labels for seed points. Select
from None (default), Number (useful when setting multiple seeds), and Tag.

•

Shadow: Allows users to enable (default) or disable the shadow effect for the seed.

•

Delete: Deletes selected seed point.
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3D Segmentation with Region Grow
Here we will use Region Grow to
segment a new object in a dataset.
To follow along, download the data
set CT_Heart from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Select Semi-Automatic [1] and
choose Region Grow [2].
• Click on the image data to set
a seed point in the object you
would like to isolate [3]
• Set the Threshold Min/Max values
to define the object [4]
• Click Connect Object [5].
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3D Segmentation with Region Grow (continued)
• The voxels fulfilling the seed
point and threshold criteria for
the region grow will be assigned
to a new object.
• The segmented object is shown
overlaid on the 2D slice data [6]
and a 3D rendering [7] is
displayed.
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3D Segmentation with Region Grow (continued)
It may be necessary to adjust the
number of neighbors used in order
to limit the region grow. This will help
prevent unwanted objects from being
segmented with the target object.
To follow along, download the data
set VH_Abdomen from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Select Semi-Automatic [1] and
choose Region Grow [2].
• Click on the image data to set a
seed point in the structure you
would like to isolate [3].
• Set the Threshold Min/Max values
to define the object [4] and click
Connect Object [5].
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3D Segmentation with Region Grow (continued)
Note that the segmentation of the
abdominal aorta in the example,
using the default 26-connected
neighbors, also assigns part of the left
lung into the object [6].
• Click Undo [7]
• Set the seed point, [8] set
Neighbors to 6-connected, [9]
and click Connect Object [10].
Note the segmentation result for
the abdominal aorta [11] no longer
contains part of the left lung.
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2D Segmentation with Region Grow
Region grow also provides the ability
to limit the region to a single slice via
the 2D Connect Type option.
To follow along, download the data
set CT_Heart from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select a data set and open
Segment.
• Select Semi-Automatic, [1]
choose Region Grow [2 and set
the Connect Type to 2D. [3].
• Click on the image data to set a
seed point. [4] The seed point
should be in the 2D structure you
would like to isolate.
• Set the Threshold Min/Max
values to define the object [5]
and click Connect Object. [6].
• The region will be isolated on the
single slice [7].
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2D Segmentation with Region Grow (continued)
• To segment multiple 2D regions,
click Undo [8].
• Click on the image data to set
multiple seed points on the
regions you want to segment [9].
• Set the Threshold Min/Max
values to define the object [10]
and click Connect Object [11].

• All of the regions falling within
the threshold criteria will be
isolated in 2D [12].
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Connected Components
The connected components tool allows users to identify groups of objects based on spatial connectivity and intensity range. This
segmentation method finds groups of voxels within a user-specified intensity range and assigns spatially disconnected groups to
independent objects. The number of objects identified is specified by the user, and objects are created in order of largest to smallest based
on the number of connected voxels in each object.
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Connected Components Options
The following Connected Components options are available:
Threshold slider: The Threshold double-ended slider bar allows users to specify a range
of threshold values using the minimum and maximum ends of the threshold slider. For a full
description of the threshold slider please refer to the Threshold Volume section.
Min and Max: The minimum and maximum input field allows users to manually enter the
minimum or maximum threshold value. There are also arrow up and down buttons the right of
the input fields to increase or decrease the currently value by 1.
Threshold Rendering: Allows users to disable and enable to 3D preview of the selected voxel
range. Disable this option by unchecking the checkbox when working with large data sets.
Connect Type: Determines if the connection type will be 3D or 2D.
3-D: Region grow will be applied to the (3D) volume.
2-D: Region grow will be limited to the current (2D) slice.
Neighbors: Allows users to select the number of neighboring voxels during the connection
process. The options available depend on the connect type. For 3D, users can choose
6-connected or 26-connected. For 2D, 4-connected or 8-connected can be selected. For a
full description of the neighbor options refer to the Region Grow section.
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Connected Components Options (continued)
Restrict Components: When enabled displays a set of criteria that can be used to restrict
the object segmentation resulting from the connected component analysis. Components
with less than or more that the values entered in the x and y parameters will be ignored
in the connected components analysis. These options specify that All Components must
have:
•

At least ‘x’ voxel(s), but no more than ‘y’ Voxels(s): Segmented components must have
at least the minimum number of voxels in its structure as specified by ‘x’ and no more
than the maximum number of voxels in its structure as specified by ‘y’.

•

A Width of ‘x’ voxel(s), but no more than ‘y’ Voxels(s): Segmented components must have a width of at least the minimum number of
voxels as specified by ‘x’ and no more than the number of voxels as specified by ‘y’.

•

At Height of ‘x’ voxel(s), but no more than ‘y’ Voxels(s): Segmented components must have a height of at least the minimum number of
voxels as specified by ‘x’ and no more than the number of voxels as specified by ‘y’.

•

At Depth of ‘x’ voxel(s), but no more than ‘y’ Voxels(s): Segmented components must have a depth of at least the minimum number of
voxels as specified by ‘x’ and no more than the number of voxels as specified by ‘y’.

Keep Largest X Component(s): Allows users to set the maximum number of objects to be kept in the connected component process.
Each Resulting Component becomes a New Object: When selected determines that each segmented component is assigned to its own
object in the object map.
Each Resulting Component defined as Current Object: When selected determines that each segmented component is assigned to the
current object selected in the object map.
Find Components: Initiates the connected components segmentation.
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Segmenting Multiple Objects Using Connected Components
Here we will use Connected
Components to segment several
objects in a dataset.
To follow along, download the data
set CT_Liver from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• In the Object Control window
click Add Object, name the
object Bone and then make sure
the object is selected [1].
• Select Semi-Automatic [2] and
choose Connected Components
[3].
• Set the threshold range [4] to isolate the spine and ribs. A minimum threshold value of 295 and a maximum of 1464 works well for this
dataset.
• Set the number of components to keep to 14 [5]
• This time select the Each Resulting Component defined as Current Object option [6]. Now all 14 isolated components will be set to a
single object.
• Click Find Components [7].
• The data will be thresholded and the largest groups of voxels specified will be identified and rendered as a single object [8].
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Object Extractor
The Object Extractor tool enables the user to define and extract objects from image data using a combination of thresholding, region
growing and morphological operations.
First, a seed point is manually set on a structure of interest. Next, a threshold range is established by the user to define the structure. The
region defined by a given threshold range is shown on the 2D slice containing the seed point using a 2D auto trace mechanism. This region
updates interactively as the threshold range is adjusted, allowing the user to determine the threshold range that properly defines the region
of interest. The Object Extractor segmentation routine is ready to be started once the seed point and threshold range define the structure
on the initial slice.
The algorithm first applies a global threshold to the data set, using the minimum and maximum values specified by the user. Next a 3D
binary erosion is performed on the binary result of the global threshold. The erosion attempts to break connections between the target
structure and neighboring regions which have similar
intensity values. The erosion is followed by a 3D
6-neighbor region grow, which uses the initial seed
point. The processed target slice on which the initial
seed point was set is compared to the initial auto trace
from the user-defined seed point and threshold range.
The erosion and region growing steps are repeated
until the set of voxels on the processed target slice are
a subset of the initial auto trace. Next, the processed
data is conditionally dilated until 99% of the voxels
in the auto traced region on the processed target
slice are recovered. Once the extraction process
is complete, the resulting object is rendered and
displayed over the 2D slice data.
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Object Extractor Options
As with the Region Grow tool, a seed
point must be set on the structure
you wish to segment [1] before
the Object Extractor options are
enabled. Note, multiple seeds can
be selected for the simultaneous
segmentation of multiple structures
with the same threshold parameters,
for example the segmentation of
both the left and right lungs. When
the seed is set the following options
become available:
Threshold slider: The Threshold
double-ended slider bar allows
users to specify a range of threshold
values using the minimum and
maximum ends of the threshold slider. For a full description of the threshold slider including right click options, please refer to the Threshold
Volume section.
Min and Max: The minimum and maximum input field allows users to manually enter the minimum or maximum threshold value. There are
also arrow up and down buttons the right of the input fields to increase or decrease the currently value by 1.
Threshold Rendering: This option allows users to disable and enable to 3D preview of the selected voxel range. It is recommended to
disable this option by unchecking the checkbox when working with large data sets.
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Object Extractor Options (continued)
Show Thresholding: When the minimum and maximum threshold values are selected the adjustment
is previewed on the 2D slice data. By default, the Show Thresholding option is set to Max Adjust.
Adjusting the minimum threshold value will display as a update of the outer boundaries of the object
only {x} while adjusting the maximum will display as a filled preview. To enable the filled preview the
following options are available.
Max Adjust: Only adjusting the maximum threshold level will preview with the filled region.

Min Adjust: Selecting Min Adjust will reverse the default preview display so that adjusting the
minimum threshold value will show a filled region while adjusting the maximum threshold values will
display the outer boundaries of the object only.
Any Adjust: Will set the filled preview display when adjusting either the minimum or maximum
threshold value.
Never: Disables the filled preview display. Both minimum and maximum threshold adjustment will
display the outer boundaries of the object only.

Select Seed: Switches to seed selection mode.
Draw Limit: Switches to limit definition mode. Allowing users to define limits on the image data to prevent the defined region from leaking
into surrounding structures.
Reset Seeds: Resets the user defined seed(s). Note, you can delete a seed point by right-click on the seed and choosing Delete. Seeds can
also by moved by left-clicking on the seed and then dragging to a new location.
Reset Limit: Resets all user defined limits.
Extract Object: Initiates the Object Extraction segmentation
process.
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Segmentation of a Single Object Using Object Extractor
Here we will use Object Extrator to
segment a single object in a dataset.
To follow along, download the data
set EGV_MRI from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Select Semi-Automatic [1]
and choose Object Extractor
[2].
• Click on the image data to set
a seed point in the object you
would like to isolate [3].
• Adjust the minimum threshold
value [4] until the auto trace
defines the object [5].
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Segmentation of a Single Object Using Object Extractor (continued)
• Adjust the maximum threshold
level and note that the red binary
mask will interactively update.
• Lower the maximum threshold
value until holes start to appear
in the red binary mask in the
structures surrounding the brain,
but not in the brain [6].

• Click Extract Object [7].
• Once segmentation is complete,
the object map will be rendered
[8] and overlaid on the slice data
[9].
• Save your work by selecting File
> Save Object Map.
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Segmentation of Multiple Objects Using Object Extractor
Here we will use Object Extrator
to segment multiple objects in a
dataset.
To follow along, download the data
set CT_Lungs from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Select Semi-Automatic [1] and
choose Object Extractor
[2}.
• Click on the image data to set
a seed point in the object you
would like to isolate. [3].
• Adjust the minimum and
maximum threshold values [4
until the auto trace defines the
object. [5].
• Select Extract Object. [6]
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Segmentation of Multiple Objects Using Object Extractor (continued)
• Once the segmentation process
is complete, the object will be
rendered [7].

• Rename the object [8]. Add
a new object [9] and rename
[10].
• Set a seed point in the next
object [11] and select Extract
Object [12].
• Once the segmentation process
is complete, the object will be
rendered [13].
• Save your work by selecting File
> Save Object Map.
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Object Separator
The Object Separator tool uses morphologic erosion to break connections between objects based on user-defined seed points to
specify objects to separate. The purpose of the tool is to break objects into two or more objects. The tool requires a minimum of two
seed points to be set.
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Object Separator Options
The following Object Separator Options are available:
Seed #1 – Define As: This option is enabled when the first seed point location is set. By default this
option is set to Current Object, that is the object currently selected in the object control window.
Selecting the drop-down menu allows users to choose from; Current Object, Not Changed (the object
that the seed voxel is already assigned to), New, and then any objects in the object list.
Seed #2 – Define As: This option is enabled when the second seed point location is set. By default this
option is set to Not Changes, that is the object the seed point voxel is currently assigned to. Selecting
the drop-down menu allows users to choose from; Current Object, Not Changed, New, and then any
objects in the object list.
Reset Seeds: Deletes all defined seed points.
Separate Objects: Begins the Object Separator process.
Seed point right click options: Right clicking on a seed point provides the following options:
Style: The style options allows users to change the of the seed point. Select from Dot, Crosshair (default), Arrow, and Diamond.
•

Label: The label options allows user to enable and disable labels for seed points. Select from None (default), Number (extremely useful
when setting multiple seeds), and Tag.

•

Shadow: Allows users to enable (default) or disable the shadow effect for the seed.

Delete: Deletes selected seed point.
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Separating Objects
Here we will use Object Separator to
disconnect objects in a dataset.
To follow along, download the data
set CT_Heart from
analyzedirect.com/data and load into
Analyze using Input/Output.

• Select the data set and open
Segment.
• Select Semi-Automatic and
choose Region Grow.
• Click on the image data to set
a seed point. The seed point
should be in the object you
would like to isolate.
• Set the Threshold Min/Max values to define the object and then click Connect Object.
• The structure will be isolated.
• Rotate the rendering to view the objects to disconnect.
• Select Object Separator [1] and click Add Object [2].
• Set a seed point on the first structure [3] and add a seed point to the second structure [4].
Object separator usually works best when the seed points are set in the orthogonal images.
• Click Separate Objects [5].
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Separating Objects (continued)
• The structures will be
disconnected and assigned to
different objects [6].
• Save your work by selecting File >
Save Object Map.
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Oblique Cutting
The Oblique Cutting tool enables the specification and display of an oblique cut plane in the volume image. The selected object can
be split at the cut plane, with the smaller region after the split assigned to a different object as specified in the object control window.
This tool is particular useful for splitting and reassigning vessels to new objects.
When the Oblique Cutting tool is selected the user must click on the image in the approximate location were the cut is to be placed,
this can be done by clicking on the rendering or any of the orthogonal views. Once selected the Obliques window will open [1] and the
oblique cut plane will be displayed on the rendering [2] and as a blue dashed line on the orthogonal displays. [3] The following Oblique
Cutting options [4] will be made available:
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Oblique Cutting Options
The following Oblique Cutting Options are available:
Cut: When the Cut option is clicked the selected object is split
at the location of the oblique cut plane, the smaller object after
the split is assigned to the object currently selected in the object
window [5]. If the same object is selected a message will be
returned stating ‘Attempting to assign cut vein to itself’. [6] Click OK
to dismiss the warning and then select or add a new object in the
object control window.
Cancel: Selecting cancels will cancel the Oblique Cut, the Oblique
Cut options will no longer be available and then Oblique Cut Plane
will be removed from the orthogonal slice displays.
Find Best: The Find Best option searches for the oblique image
which contains the most circular representation of the selected
object.
Recenter: Recenters the oblique plane. The center of the selected
object on the oblique plane is computed. The oblique plane is then
adjusted so that this computed center is displayed as the center in
the oblique window.
Additional Options: The oblique cut plane can be adjusted by
dragging an edge of the plane on the rendered image or by
dragging the endpoints or center of the cut plane lines displayed on
the orthogonal images.
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Oblique Cutting of Objects
Here we will use Oblique Cutting to
specify and display an oblique cut
plane in a dataset.
To follow along, download the data
set Cardiac_CT from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Select Semi-Automatic [1] and
choose Region Grow [2].
• Set a seed point in the middle of
the left atrium [3].
• Define a threshold range to
describe the blood pool [4] and
click Connect Object [5].
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Oblique Cutting of Objects (continued)
• Add a new object and name it RCA (right coronary artery) [6].
• Select Oblique Cutting [7].
• Rotate the rendering of the heart so the RCA is visible [8].
• Move your cursor to the base of the RCA and click to set a seed point on the RCA [9].
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Oblique Cutting of Objects (continued)
• The Segment interface will update while the Oblique Cutting algorithm finds the best plane to cut the RCA from the main heart object.
• If the computed cut plane is not ideal you can adjust the plane interactively on the rendering [10] or on any of the slice displays [11].
• The navigation tools can also be used on the oblique image [12].
• Select Cut [13] to cut the data.
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Oblique Cutting of Objects (continued)
• The RCA will be separated from
the main object and assigned to
the RCA object [14].
• To return to the regular display,
click on the Toggle Obliques
button to switch off the display of
the oblique image.
• Select File > Save Object Map to
save your work.
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Fill Holes
The Fill Holes function performs a flood-fill operation on the
selected object. The operation reassigns voxels belonging to
other objects to the selected object. The fill operation stops
when it reaches the boundary of the object.
Fill Type: The fill type option allows users to select from the
following fill type operations:
•

3-D: Fills three dimensional holes in the volume. This
option is useful for filling small holes in the image data.

•

3-Pass: This option fills holes by process the volume,
image by image in all three orthogonal directions.

•

2-D All Images: Conducts a 2D region fill on all 2D slices
in the selected orientation.

•

2-D Current Image: Conducts a 2D region fill on the
current 2D slice.

Set Current Object to Selection: Allows users to enable
(default) or disable setting the filled region to the same object
as being filled. Keep this option enabled if you wish to fill
holes in an object and have them assigned to the same object
[1], uncheck and disable this option if you wish to have the
voxels that fill the holes in the object assigned to a different
object, an object that is selected from the object list [2].
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Filling Holes in Objects
After the initial segmentation, an
object may contain holes, which are
voxels belonging to the Original
object. To obtain an accurate volume
measurement and to ensure the object
is whole, it may be necessary to apply
a fill holes operation on the object.
To follow along, download the data
set EGV_MRI from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Select Semi-Automatic [1] and
choose Object Extractor [2].
• Click on the image data to set a
seed point.
• Adjust the minimum and
maximum threshold values [3] to
define the structure and select
Extract Object [4].
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Filling Holes in Objects (continued)
• To remove small holes in the
object [5] which are a result of the
segmentation parameters, select
Fill Holes [6].
• With the Fill Type set to 3D, [7] click
on the object to fill smaller holes in
the object [8]

• To fill larger holes, such as the
ventricular CSF, use the 3-Pass Fill
Type [9] and click on the brain [10].
All larger holes will be filled and
assigned to the object.
• Select File > Save Object Map to
save your work.
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Using Fill Holes for Segmentation
The fill holes option can also be used
as a strategy to segment multiple
objects. In this example we isolate the
adipose tissue via threshold-based
segmentation from a water-suppressed
MRI data set. We will then use fill holes
to create the muscle object and the
intramuscular adipose tissue object.
To follow along, download the data set
Thigh_MRI from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Select Semi-Automatic [1] and
choose Threshold Volume [2].
• Set a threshold range [3] to globally
segment the adipose tissue and
click Threshold Object [4].
• The adipose tissue will be
segmented [5].
• Rename the object [6], add a new
object [7] and name it Muscle.
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Using Fill Holes for Segmentation (continued)
• Select Fill Holes [8] and set the Fill
Type to 3-Pass [9].
• Uncheck the Set Current Object to
Selection [10] checkbox.
• Ensure that the Muscle object
is selected [11] and click on the
Adipose Tissue object [12]. The
voxels inside the Adipose Tissue
object currently assigned to the
Original object will be reassigned to
the Muscle object [13].
• To assign the voxels labeled as
Adipose Tissue within the Muscle
object to Intramuscular Adipose
Tissue (IMAT).
• Add a new object [14] and name it
IMAT.
• Click on the Muscle object to fill it
[15]. The voxels inside the Muscle
object currently assigned to the
Adipose Tissue object will be filled
and assigned to the IMAT object
[16].
• Select File > Save Object Map to
save your work.
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Morph Objects
The Morph Objects option allows users to apply rudimentary morphological operations to objects. The operations available are dilate,
erode, open and close. Additional morphological operations are accessible from the Morphology tool in Process. The following Morph
Objects options are available:
Operation: The operation drop-down menu allows users to
select the morphological operation to perform. Choose from:
•

Dilate: Adds a layer of voxels to an object, increasing the
size of the object by increasing the objects boundaries
while reducing the size of holes in the object [1].

•

Erode: Removes a layer of voxels from an object, decreasing
the size of the object by eroding the objects boundaries
and increasing the size of holes in the object [2].

•

Open: Performs an erode followed by a dilate [3]. In
general, an open is less destructive than an erosion. The
effect of the operation is to preserve voxels that have a
similar shape to the structuring element, while removing
other regions from the object. The effect on the image can
be subtle as indicated in the image below.

•

Close: Performs an dilate followed by a erode [4]. The close
operation is similar to the dilate operation in that it tends to
increase the object boundaries and shrink holes within the
object. However, the close operation is less destructive of
the original object boundary.
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Morph Objects (continued)
Element Shape: Allows users to choose between a jack [1] or box [2] shaped
element.
•

Jack: A jack-shaped structuring element includes only the orthogonal
elements to the center voxel of the structuring element. In a 3x3x3
jack-shaped structuring element, there are 7 voxels - one center voxel
surrounded by the 6 orthogonal neighbors. The diagonal voxels are not
part of this structuring element [1].

•

Box: A rectilinear structuring element is a solid rectangle (or cube) of the given size in X, Y, and Z. For example, a 3x3x3 rectilinear
structuring element is a 27-voxel cube - one center voxel surrounded by 26 orthogonal and diagonal voxels [2].

Element Size: The element size, sometimes referred to as kernel size, allows users to set the X, Y, and Z dimensions of the selected element
shape that will be used in the chosen morphological operation.
•

X: The X option allows users to specify the width of the structuring element. Select 1, 3, 5, 7, 9, or enter an odd numbered value into the
text entry field.

•

Y: The Y option allows users to specify the height of the structuring element. Select 1, 3, 5, 7, 9, or enter an odd numbered value into the
text entry field.

•

Z: The Z option allows users to specify the depth of the structuring element. Select 1, 3, 5, 7, 9, or enter an odd numbered value into the
text entry field.

Note, to specify a 2D element set any of the dimensions to 1. A 3x3x3 jack-shaped structuring element will erode away or dilate (add) a
single layer of voxels on the structure, a 5x5x5 structuring element will generally take away or add two voxels, etc.
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Morph Objects (continued)
Use Conditional Volume: The use conditional volume option is only available for the dilate operation. When selected the option allows a
user to limit the dilation of the current object, conditioning the results with a volume selected from the workspace. The voxels that exist in
the conditional volume define a ‘mask’ for voxels to be processed in the current volume. When selected the following options are available
to choose the conditioning volume:
•

Workspace: Allows the user to select the workspace that contains the conditional volume.

•

Name: Allows user to select the volume to use as the conditional volume. Note volumes can be binary or grayscale.

•

Drag and drop here: Allows users to select the conditional volume via drag-and-drop from the workspace.

Set Current Object to Selection: The
Set Current Object to Selection option
is only available for the dilate and close
operations. The option allows users to
enable (default) or disable setting the
current object as the selected object for
the output of the morphological operation,
that is the voxels that will be added to the
object once the dilate or close operation
is complete. Keep this option enabled if
you wish to assign the additional voxels to
the same object [5], uncheck and disable
this option if you wish to have assign the
additional voxels to a different object, an
object selected from the object list. [6]
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Using Morph Objects to Improve Segmentation
Here we will improve the segmentation of an object by applying rudimentary morphological operations to the object.
To follow along, download the data set MRI_3D_Head from analyzedirect.com/data and load into Analyze using Input/Output.
• Select the data set and open
Segment.
• Select Semi-Automatic [1] and
choose Object Extractor.
• Click on the image data to set a
seed point.
• Adjust the minimum and
maximum threshold values to
define the structure and select
Extract Object.
• Once the object is segmented,
rename and update the color.
• Choose Morph Object [2] and
set Operation to Erode [3].
• Leave the element size set to 3
X 3 X 3.
• Set the target object to Original
[4]. This will specify that any
eroded voxels will be reassigned
to the Original object.
• Now click on the brain [5] to
initiate the erosion.
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Using Morph Objects to Improve Segmentation (continued)
• Select Filter Objects [6] and
apply a 3 X 3 X 3 Mode filter
to the brain by clicking Filter
Objects [7].

• Select Morph Objects [8] and set
the Operation to Dilate [9].
• Select the Brain object [10] and
click on the brain [11].
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Using Morph Objects to Improve Segmentation (continued)
Note the difference between the pre
[12] and post [13] processed brain
objects.

Analyze 14.0 User’s Guide

© AnalyzeDirect, Inc.

SEGMENT > SEMI-AUTOMATIC TOOLS

378

Filter Objects
Filtering objects is a simple and
intuitive way to reduce noise, fill
small holes, and smooth object
edges. Filtering objects reduces
the amount of variation between
the pixels (2D) or voxels (3D) that
make up the object. The filtering
process simply replaces each pixel or
voxel with a function of itself and its
neighbors, defined by the element
size selected.
The filter is only applied to
segmented objects and does not
change the original data. If after
attempting to segment a structure
from a data set you decide that
filtering the grayscale image data
would improve the segmentation
result refer to the Process module
> Spatial Filters processing type to
access all of the software’s filtering
options.
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Filter Objects Options
Operation: Three filtering operations are available:
• Mode: The mode filter replaces the target voxel with the mode of the neighborhood of voxels
specified by the element size. The value repeated most often is the mode.
• Median: Like the mode filter the median filter considers each voxel in the neighborhood
specified by the element size to replace the target, however, instead of simply replacing the
voxel with the mode of the neighboring voxel values, it replaces is with the median of those
values. The median is calculated by first sorting all the voxel values into numerical order and
then replacing the target voxel with the middle voxel value.
• Rank: Like the median filter the rank filter first sorts the values with in the neighborhood
specified by the element size, numerically. However, the value used to replace the target voxel
is dependent upon the rank value selected by the user using the Rank Slider.
·· Rank Slider: The slider allows users to specify of rank value used. The range of rank values
is dependent on the neighborhood of voxels used for the filter, which is controlled by the
element size. For example, in a 3x3x1 region the minimum rank value would be 1 while the
maximum rank value would be 9. If the rank value was set to 6, the corresponding voxel value
for that ranked voxel would by used to replace the target voxel.
Element Size: Allows users to set the X, Y, and Z dimensions of the rectilinear element to be used in the selected filtering operation.
• X: allows users to specify the width of the element. Select 1, 3, 5, 7, 9, or enter an odd numbered value into the text entry field.
• Y: allows users to specify the height of the element. Select 1, 3, 5, 7, 9, or enter an odd numbered value into the text entry field.
• Z: allows users to specify the depth of the element. Select 1, 3, 5, 7, 9, or enter an odd numbered value into the text entry field.
Filter Objects: Initiates object filtering. Note that object filtering does not
honor object locking, and locked objects will be filtered. If any objects in the
object list are locked a message will be returned stating that locked objects
have been detected and object filtering does not honor locks. The option to
cancel (No) or to continue (Yes) with the filtering operation will be given.
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Using Filter Objects to Improve Segmentation
Here we will improve the
segmentation of an object by using
Filter Objects.
To follow along, download the data
set Mouse_Lungs from analyzedirect.
com/data and load into Analyze
using Input/Output.
• Select the data set and open
Segment.
• Select Semi-Automatic [1] and
choose Region Grow [2].
• Set a seed point on the object
you want to isolate [3] and set a
threshold range [4] that describes
the object.
• Click Connect Object [5].
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Using Filter Objects to Improve Segmentation (continued)
• Select Filter Objects. [6].
• Set the Operation to Mode.
[7]
• Set the Element Size to 5 X 5 X
5 [8] and select Filter Objects
[9].

Note the difference in the 2D and
3D regions between the unfiltered
[10] and filtered [11] segmentation
results. Filtering has filled small holes,
removed noise around the surface of
the lung parenchyma and smoothed
the contours of the segmentation.
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Propagate Objects
The Propagate Objects tool uses shape-based
interpolation to extend the definition of a
region to slices of the volume on which it was
not defined. For example, if the user defines
a region on every fifth slice, this tool could
be used to fill in the region on the skipped
slices. The user must specify the direction in
which objects are propagated by choosing
the orthogonal orientation in which they were
defined. A smoothing option is available which
filters the objects to produce a smoother
segmentation result.
The following options are available:
Propagation Type: choose between propagating the current object (default) selected
from the object list or all objects in the object list.
Axial: Select axial if the regions to propagate were defined in this orientation.
Coronal: Select coronal if the regions to propagate were defined in this orientation.
Sagittal: Select sagittal if the regions to propagate were defined in this orientation.
Smoothing: Enables a smoothing operation to be applied to the object(s) after
propagation is completed.
Propagate Object: Initiates the region propagation process.
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Using Propagate Objects
Here we will extend the definition of
a region using Propagate Objects.
To follow along, download the data
set CT_Liver from analyzedirect.com/
data and load into Analyze using
Input/Output.
• Select the data set and open
Segment.
• Select Manual [1] and choose
Spline [2].
• Set the primary display to Coronal
[3] and double-click on Slice [4] to
move to coronal slice 100.
• Adjust the display intensity, [5] if
desired.
• Trace a spline around the liver [6]
and select Apply [7].
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Using Propagate Objects (continued)
• Move to coronal slice 125 and
trace the liver [8].
• Repeat on coronal slices 150 [9]
and 175 [10].

• Select Semi-Automatic [11] and
Propagate Objects [12].
• Set the propagation orientation
to Coronal [13] and click
Propagate Object [14].
• After the object propagation
process is complete, the liver
object will be defined from slice
100 to slice 175. The object can
be reviewed in each orientation
and the 3D rendering.

Analyze 14.0 User’s Guide

© AnalyzeDirect, Inc.

385

SEGMENT > MANUAL TOOLS

Manual Tools
The Manual tab provides users with access to interactive segmentation tools for manual 2D slice-based segmentation. These tools allow
users to define regions with precision while reducing the time required to perform manual segmentation.
The Manual Tools that will described in this section include the following:
•

Freehand Draw

•

Manual Trace

•

Auto Trace

•

Polygon Trace

•

Spline Trace

•

Smart Trace

•

Reassign Object

•

Nudge Edit

•

Divide Regions

•

Adjust Regions

•

Fabricate Shape(s)
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Freehand Draw
The Freehand Draw tool lets the user draw regions of interest directly onto the image data. The
following options are available.
Pen Shape: The pen shape option [1] allows users to specify the shape of the pen for region
definition, choose from Round, Square, or Diamond.
Pen Size: The pen size slider [2] provides users with the ability to adjust the size of the pen used
for region definition. The pen size ranges from 1 to 100 pixels. Note that the real-world size of the
pen is reported below the pen size slider [3].
Current Pen: The current pen icon [4] is a quick reference tool for users, displaying the selected
pen shape, pen size, and object color of the selected object from the object list.
Draw Many: The draw many option allows users to enable (default) or disable the draw many
option. Enable this option is you wish to draw a continuous region, [5] disable the option is you
wish to draw a single region as defined by the pen shape, pen size, and selected object [6].
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Freehand Draw (continued)
Thick Edit: The thick edit option allows users to apply edits (region definitions) defined on
the current slice to other slices in the volume. When thick is enabled the following options are
available:
•

Slices(s) Before: Specifies the number of slices before the current slice in which to apply the
edits.

•

And After: Specifies the number of slices after the current slice in which to apply the edits.

Auto Advance: The auto advance option automatically moves users to a new slice, as defined
by the auto advance options, once the current edit is defined. Note the auto advance will occur
after the user releases the left mouse button and the edit is applied to the current slice. The auto
advance option is a productivity tool allowing users to move through the image data without
having to move the cursor from the current orientation window that regions are being defined on.
The following options are available.
•

Off: Off is the default option for auto advance. When off is selected auto advance is disabled.

•

Forward: Specifies that auto advance will move forward through the image data (slice number
increases).

•

Backwards: Specifies that auto advance will move backwards through the image data (slice
number decreases).

•

Increment: Specifies the number of slices the auto advance will move forward or backwards.
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Using Freehand Draw to Define a 2D Region
Freehand Draw allows easy definition
of 2D regions.
To follow along, download the data
set EGV_MRI from analyzedirect.
com/data and load into Analyze
using Input/Output.
• Select the data set and open
Segment.
• Select Manual [1] and choose
Freehand Draw [2].
• Use the Pen Size slider to change
the Pen Size to 20 [3].
• The Current Pen [4] will update to
the color of the currently selected
object [5].
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Using Freehand Draw to Define a 2D Region (continued)
• Left-click on the image and drag
the cursor to trace a region [6].
• Releasing the left mouse button
will end the trace [7].

•

Continue to define the brain
using the pen tool [8].
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Using Freehand Draw to Define a Single Shape on a 2D Slice
The Freehand Draw tool allows users
to define a single circle, square, or
diamond.
To follow along, download the data
set EGV_MRI from analyzedirect.
com/data and load into Analyze
using Input/Output.
• Select the data set and open
Segment.
• Select Manual [1] and choose
Freehand Draw [2].
• Set the Pen Shape to Square [3]
and change the Pen Size to 25 [4].
• Uncheck the Draw Many option
[5].
• Click on the image to define a
square. [6]
• Additional squares can be defined
by clicking on the slice again.

Analyze 14.0 User’s Guide

© AnalyzeDirect, Inc.

SEGMENT > MANUAL TOOLS

391

Using Freehand Draw to Define a Single Shape in 3D
The Freehand Draw tool allows users
to define a single shape (circle, square,
or diamond) over many slices. This can
be helpful when defining regions that
are constant through the 3D volume.
To follow along, download the
data set CLS_Bone_Phantom from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Select Manual [1] and choose
Freehand Draw. [2]
• Change the Pen Size to 50 [3] and
uncheck the Draw Many option [4].
• Check the Thick Edit option [5].
• To define the phantom insert on multiple slices, use the Slice(s) Before and After options [6] to specify the extent of propagation of the
2D region through the data set. In this example, set both parameters to 180.
• Click on an insert [7] to define a region, and note that you can move the 2D region around. The region will not be defined until the left
mouse button is released.
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Using Freehand Draw to Define a Single Shape in 3D (continued)
Once the left mouse button is released the regions will be applied to the specified slices. Note the update in the coronal [8] and Sagittal [9]
orientations and the 3D rendering [10].
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Using Freehand Draw to Paint Regions of Interest
The Freehand Draw tool is particularly
useful for manually defining or filling
regions between locked objects,
specifically when the region of
interest is not easily segmentable but
the surrounding tissue is.
To follow along, download the
data set VH_Abdomen from
analyzedirect.com/data and load into
Analyze using Input/Output.

• Select the data set and open
Segment.
• Select Semi-Automatic [1] and
choose Threshold Volume [2].
• Change the name of the current object to Other, then add two new objects: VAT (visceral adipose tissue) and SAT (subcutaneous adipose
tissue) [3].Select the Other object and use global thresholding to assign voxels having intensity values of 0 to 81 and 91 to 247 to the
Other object. This will assign all of the non-adipose tissue voxels to the Other object.
• Lock the Other object [4].
For more information on threshold-based segmentation, refer to Threshold Volume.
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Using Freehand Draw to Paint Regions of Interest (continued)
• Select Manual [5] and choose
Freehand Draw [6].
• Set the Pen Shape to Diamond
[7] and change the Pen Size to
20 [8].
• Select the VAT object [9] and
note that the Current Pen [10] will
update to the color of the VAT
object.
• Use the pen tool to draw over
the VAT regions [11].
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Using Freehand Draw to Paint Regions of Interest (continued)
• Once the VAT region is defined,
lock the VAT object [1 and
select the SAT object. [1
• Increase the Pen Size to 30 [14
and draw over the SAT regions
[15].

•

When finished, [16] use File > Save
Object Map to save your work.
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Manual Trace
Like the Freehand Draw tool, the
Manual Trace tool allows the user to
draw regions of interest directly onto
the image data. Manual tracing allows
contours to be drawn around the
edges of a region of interest.
When the Manual Trace tool is
selected the following options are
available:
Thick Edit: The thick edit option
allows users to apply edits (region
definitions) defined on the current
slice to other slices in the volume.
When thick is enabled the following
options are available:
•

Slices(s) Before: Specifies the number of slices before the current slice in which to apply the edits.

•

And After: Specifies the number of slices after the current slice in which to apply the edits.

Auto Advance: The auto advance option automatically moves users to a new slice, as defined by the auto advance options, once the current
edit is defined. Note the auto advance will occur after the user releases the left mouse button and the edit is applied to the current slice.
The auto advance option is a productivity tool allowing users to move through the image data without having to move the cursor from the
current orientation window that regions are being defined on. The following options are available.
•

Off: Off is the default option for auto advance. When off is selected auto advance is disabled.
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Manual Trace Options (continued)
Auto Advance (continued):
•

Forward: Specifies that auto advance will move forward through the image data (slice number increases).

•

Backwards: Specifies that auto advance will move backwards through the image data (slice number decreases).

•

Increment: Specifies the number of slices the auto advance will move forward or backwards.

Right click options: Right clicking on a trace when Auto Trace is selected will provide access to the following additional editing options:
•

Edit Type: Allows users to switch between the modify trace and split trace edit modes.
·· Modify Trace: The modify trace option is the default mode for manual trace editing. If the cursor is held over the boundary of an
object when tracing begins the edit will apply to that object whose boundary is being modified, regardless of the object selected
from the object list. If you wish to have edits applied to the object selected in the object list uncheck the Auto Set Object option. For
more information on how to edit a trace refer to Manual Contour Tracing and Editing.
·· Split Trace: Split trace mode allows the
current object to be edited [1] and split into
two objects with the smaller section of the
trace being assigned to the object selected
in the object list. If the object selected is the
same as the object being split the smaller
section will be automatically assigned to a
new object [2].
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Manual Trace Options (continued)
Right click options (continued):
•

Adjust Line Thickness: The adjust line thickness options allows users to switch the thickness display of the traced boundaries of objects.
When enabled (default) traces appear thicker, [3] when disabled traces appear thinner. [4]

•

Delete: Deletes selected region.

•

Delete All: Deletes all regions on the slice.

•

Auto Set Object: When enabled (default) edits made to object boundaries in Modify Trace mode are assigned to the object being
edited. Unchecking the option will ensure boundary edits are assigned to the object selected in the object list.
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Manual Contour Tracing and Editing
To perform contour tracing and
editing using Manual Trace, use the
following steps.
To follow along, download the
data set MRI_3D_Head from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Select Manual [1] and choose
Manual Trace [2].
• Left-click on a slice to begin
tracing and move the cursor
around the region you want to
define [3].

• Release the left mouse button to
complete the trace [4].
• To edit the trace and add pixels
that may be missing [5], click on
the trace [6].
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Manual Contour Tracing and Editing (continued)
• After clicking on the trace, draw
in the missing region [7].
• To edit the trace and remove
additional pixels [8], hover near
the edge of the contour until the
cursor changes to a + sign, then
drag the cursor into the trace [9].

• Adjust the trace to remove the
undesired pixels [10].

Analyze 14.0 User’s Guide

© AnalyzeDirect, Inc.

SEGMENT > MANUAL TOOLS

401

Manual Trace and Auto Advance
Here we will use the Auto Advance
function of Manual Trace to
automatically move forwards and
backwards through image data as the
region of interest is defined.
To follow along, download the
data set MRI_3D_Head from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Select Manual [1] and choose
Manual Trace [2].
• Set Auto Advance to Forward [3].
• Add an object and name it Right
Ventricle [4].
• Move to Axial slice 133 [5].
• Left click on the border of the
right ventricle and trace the
structure [6]. When complete
release the left mouse button.
The trace will be applied to this
slice, and the next slice forward,
slice 134, will appear.
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Manual Trace and Auto Advance (continued)
• Continue tracing the right
ventricle in this manner until slice
139 is reached.
• At slice 139 add a new object and
name it Left Ventricle [7]. Make
sure the new object is selected.
• Change the Auto Advance option
to Backward [8]
• Left click on the border of the left
ventricle and trace the structure
[9]. When complete release the
left mouse button. The trace will
be applied to slice 139 and slice
138 will appear. Continue tracing
the left ventricle until slice 133 is
reached.
Tip: Object regions can be deleted by holding the cursor over the
object and then pressing the delete key on your keyboard. Note
that the first time you delete an object in this way for the current
segmentation session you will be prompted on which action to take;
don’t delete (No), delete (Yes), delete and don’t prompt this message
in the future (Yes, always), don’t delete and don’t prompt this
message in the future.
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Auto Trace
The Auto Trace tool enables the user to
define and extract regions of interest from
the image data using 2D seeded region
growing. Region definition begins with a
seed pixel, manually set by the user, on a
structure of interest. Next, a threshold range
is established by the user to define the
boundary of the structure. The 2D region
is defined by all the pixels in the threshold
range that are connected to the seed pixel.
The following options are available:
Select Seed: The select seed mode is the
default mode the Auto Trace tool will open
in. Select seed allows users to set a seed
point on the image data [1] to enable the
Auto Trace tool options.
Draw Limit: The draw limit mode allows
users to manually define limits on the image
data to limit the auto trace region [2].
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Auto Trace Options (continued)
Object Restrict: The Object Restrict options
allows users to restricts the definition of the
current object with the boundaries of any
established objects. When disabled traces
are not limited by object boundaries [1].
However, when the option is enabled traces
are restricted [2].
Threshold slider: The Threshold doubleended slider bar allows users to specify a
range of threshold values using the minimum
and maximum ends of the threshold slider.
Minimum and Maximum values can be
entered in the text entry fields while the
arrow up and down keys to the right of the
minimum and left of the maximum text entry
fields can be used to increase or decrease
values 1 point at a time. Click left and right of
the text entry boxes
Tip: Clicking in the trough to either side of
the minimum or maximum end of the slider
will advance the value by 1. Shift-click will
decrease the value by 1.
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Auto Trace Options (continued)
Right clicking options: Right clicking on
the threshold slider will provide access to
threshold presents. The Presets option allows
users to select predefined thresholds or
define new threshold values for specific areas
of interest. For more information on Presets,
including how to configure presents refer to
the Threshold Volume.
Border: The Border options allows users to
specify how the border of the trace will be
displayed on the image, choose from:
•

On Edge: The auto trace will be
positioned exactly on the edge of the
thresholded region (top image).

•

Off Edge: The auto trace will be
positioned one pixel off the edge of the
thresholded region (middle image).

•

Fill: The auto trace will display On Edge
with a filled interior (bottom image).
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Auto Trace Options (continued)
Exterior Only: The Exterior Only
option allows users to enable (default)
or disable the display of the exterior
border only. Enable the option if you
only wish to see the exterior borders
of the trace, uncheck and disable the
option if you wish to view the exterior
and interior borders. The option is
compatible for all Border displays.
•

Top image: Exterior Only disabled
with On Edge selected

•

Middle Image: Exterior Only
disabled with Off Edge selected

•

Bottom image: Exterior Only
disabled with On Fill selected
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Auto Trace Options (continued)
Auto Limit: The Auto Limit option
applies a post processing step to
the auto trace to eliminate thin
portions of the auto trace. This option
performs a morphologic open using
the Gap Size value, defined by the
user, to define the number of layers to
be removed from the trace and then
added back.
To use the option, after setting a
seed point and appropriate threshold
criteria to define a region [1], click the
Auto Limit check box [2], then set the
Gap Size using the slider, [3] review
the impact on the defined region.
[4] Note that the Gap Size of 0 is the
same as having no Auto Limit set.
This option helps eliminate the need
for manually defining limits in some
situations.
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Auto Trace Options (continued)
Seeds share parameters: The Seeds share parameters option allows users to enable or disable (default) seeds from sharing the same
auto trace options including threshold range, border settings, auto limit, and object information. Enable this option if you wish to define
multiple separate regions with the same parameters, keep this option disabled if you wish to define multiple separate regions with different
parameters.
Reset Seed(s) after Apply: After applying the trace all seeds will be reset (deleted).
Reset Limit(s) after Apply: After applying the trace all limits will be reset (deleted).
Apply: Applies the trace to the slice.
Cancel: Cancels the Auto Trace, resets all defined seed points and limits.
Reset Seeds: Resets all seeds.
Reset Limits: Resets all limits.
Auto Advance: The auto advance option automatically moves users to a new slice, as defined by the auto advance options, once the current
edit is defined. Note the auto advance will occur after the user releases the left mouse button and the edit is applied to the current slice.
The auto advance option is a productivity tool allowing users to move through the image data without having to move the cursor from the
current orientation window that regions are being defined on. The following options are available.
•

Off: Off is the default option for auto advance. When off is selected auto advance is disabled.

•

Forward: Specifies that auto advance will move forward through the image data (slice number increases).

•

Backwards: Specifies that auto advance will move backwards through the image data (slice number decreases).

•

Increment: Specifies the number of slices the auto advance will move forward or backwards.
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Using Auto Trace to Define a 2D Region of Interest
To follow along, download the
data set MRI_3D_Head from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Select Manual [1] and choose
Auto Trace [2].
• Set the primary display to Axial
[3] and double-click Slice [4] to
move to axial slice 122.
• Set a seed pixel in the white
matter [5].
• Rename Object_2 to Brain [6]
and then adjust the minimum and
maximum threshold values [7] to
define the brain.
• Click Apply [8] to trace the brain
on this slice.
• Scroll forward to slice 123. The
+ key can also be used instead if
your mouse has no scroll wheel.
• As the seed point and threshold
range are carried forward, the
brain will be redefined on this slice.
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Using Auto Trace to Define a 2D Region of Interest (continued)
• Set the Auto Advance option to
Forward [8] and click Apply [9]. The
brain will be traced on this slice and
the display will automatically move
forward to slice 124.
• Continue to apply the auto trace
to the brain up to slice 133. If the
initial seed point is copied to a
slice where it does not fall within
the brain, reset the seed point and
threshold range and click Apply to
set a new auto trace on that slice.
• Click in the ventricular CSF to set a
seed point [10].
• Add a new Object and rename it
vCSF [11]. Note that the second
seed point will change color
to match the color of the new
object. Adjust the threshold
range to define the vCSF object
[12].
• Set a second seed point to define
the remaining vCSF [14] and click
Apply [15].
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Using Auto Trace to Define a 2D Region of Interest (continued)
• Continue clicking Apply to trace
the Brain and vCSF objects. If a
seed point is copied to a location
where it is no longer on the target
object [16], move the seed point
back onto the object [17] and
continue to apply the auto trace.
• Stop defining objects at slice 137.
• Select File > Save Object Map to
save your work.
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Polygon Trace
The Polygon Trace tool enables the definition of a closed polygon region.

The following options are available:
Reset Polygon Trace after Apply: Resets (deletes) the polygon trace after the region is defined. Polygon traced regions are defined after the
user double-clicks or presses the escape (Esc) key to close the trace ending the tracing process, the trace is applied when the Apply button is
clicked, the ‘A’ key on your keyboard is pressed, the user right-clicks on the spline trace and selects Apply from the menu or the Auto Apply
option is enabled.
Auto Apply: When selected the polygon trace is automatically applied once the user double-clicks or presses the escape key to close the
trace.
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Polygon Trace Options
Auto Advance: The auto advance option automatically moves users to a new slice, as defined by the auto advance options, once the current
edit is defined. Note the auto advance will occur after the user releases the left mouse button and the edit is applied to the current slice. The
auto advance option is a productivity tool allowing users to move through the image data without having to move the cursor from the current
orientation window that regions are being defined on. The following options are available.
•

Off: Off is the default option for auto advance. When off is selected auto advance is disabled.

•

Forward: Specifies that auto advance will move forward through the image data (slice number increases).

•

Backwards: Specifies that auto advance will move backwards through the image data (slice number decreases).

•

Increment: Specifies the number of slices the auto advance will move forward or backwards.

Right click options: Right clicking on the Polygon trace provides users with the following options:
•

Apply: Applies the trace.

•

Cancel: Cancels the trace, deleting the trace and controls points.

•

Auto Apply on Control Point Adjust: This option is only available when Auto Apply is enabled and when editing a Polygon trace or trace
converted to a Polygon. When selected any edits made to the Polygon will be automatically applied when a control point is moved.

•

Delete Control Point: Deletes the control point the cursor if currently over.

•

Delete Spline: Deletes the trace and controls points.

Note: Clicking on an object border [1]
when the Polygon Trace is selected
will convert the object region into a
polygon [2] with adaptable control
points [3].
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Region Definition and Region Modification with Polygon Trace
Here we will use the Polygon Trace
tool to define a region of interest
and then how to divide a region into
subregions.
To follow along, download the
data set MRI_3D_Head from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Select Manual [1] and choose
Polygon Trace [2].
• To define a Polygon trace around
the brain in the axial image, left
click on the image to set the first
control point [3] and then move
the cursor and left click again to
set a second control point [4].
• Continue in defining the border
or the brain in this manner until
complete [5]. Double-click or press
the Esc key to end tracing and
then process Apply [6] to define
the region.
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Region Definition and Region Modification with Polygon Trace (continued)
• Select File > Reset Object
Map to delete the trace, select
‘Continue without Saving’ when
prompted.

• Next, segment the brain in 3D
using the Object Extractor. Select
the Semi-Automatic tab [7] and
then choose Object Extractor [8].
• Click Add Object [9] to add an
object to the object list and then
click in the white matter on axial
slice 123 to set a seed point [10].
• In the Threshold option set the
minimum threshold value to 49
and the maximum to 140 [11] and
then click Extract Object [12].
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Region Definition and Region Modification with Polygon Trace (continued)
• To subsegment a 2D region
do the following. Select the
Manual tab [13] and then choose
the Polygon tool [14]. Lock the
Original object and then add a
new object to the object list [15].
• Switch off the Linked Cursor [16]
and then use the Polygon tool to
define the left hemisphere of the
brain on axial slice 123, [17] and
then click Apply [18].
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Region Definition and Region Modification with Polygon Trace (continued)
• The brain on slice 123 has been
split into two objects representing
the left and right hemisphere [18].
• The Polygon trace tool can also
be used to edit 3D objects. To
subsegment a 3D region define
a Polygon trace over the left
hemisphere of the brain in the
Rendering window [19] and then
click Apply [20].

• All voxels not assigned to a
locked object within the trace
(and all voxels along the ray path)
have be assigned to the selected
object [21].
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Spline Trace
The Spline Trace tool allows users
to define curved regions of interest.
Splines are flexible curve traces with
movable control points that are useful
for creating smooth edge traces.
The available options are as follows:
Reset Spline Trace after Apply:
Resets (deletes) the spline trace after
the region is defined. Spline traced
regions are defined after the user
double-clicks or presses the escape
(Esc) key to close the trace ending the
tracing process, the trace is applied
when the Apply button is clicked, the
‘A’ key on your keyboard is pressed,
the user right-clicks on the spline
trace and selects Apply from the
menu or the Auto Apply option is
enabled.
Auto Apply: When selected the
spline trace is automatically applied
once the user double-clicks or presses
the escape key to close the trace.
Analyze 14.0 User’s Guide

© AnalyzeDirect, Inc.

SEGMENT > MANUAL TOOLS

419

Spline Trace Options
Auto Advance: The auto advance option automatically moves users to a new slice, as defined by the auto advance options, once the current
edit is defined. Note the auto advance will occur after the user releases the left mouse button and the edit is applied to the current slice. The
auto advance option is a productivity tool allowing users to move through the image data without having to move the cursor from the current
orientation window that regions are being defined on. The following options are available.
•

Off: Off is the default option for auto advance. When off is selected auto advance is disabled.

•

Forward: Specifies that auto advance will move forward through the image data (slice number increases).

•

Backwards: Specifies that auto advance will move backwards through the image data (slice number decreases).

•

Increment: Specifies the number of slices the auto advance will move forward or backwards.

Right click options: Right clicking on the Spline trace provides users with the following options:
•

Apply: Applies the trace.

•

Cancel: Cancels the trace, deleting the trace and controls points.

•

Auto Apply on Control Point Adjust: This option is only available when Auto Apply is enabled and when editing a Spline Trace or trace
converted to a Spline Trace. When selected any edits made to the trace will be automatically applied when a control point is moved.

•

Delete Control Point: Deletes the control point the cursor if currently over.

•

Delete Spline: Deletes the trace and
controls points.

Note: Clicking on an object border
when the Spline Trace is selected
will convert the object region into a
spline with adaptable control points.
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Using Spline Trace to Define a Region of Interest
• Select a data set and open
Segment.
• Select Manual [1] and choose
Spline Trace. [2]
• Set the primary display to Coronal
[3] and double-click Slice [4] to
move to coronal slice 100.
• To begin drawing a spline,
position the cursor on the image
and left-click [5]. Reposition the
cursor and left-click to continue
drawing the spline around the
object of interest [6.]
• Double-click to end and close
the spline.
• Note that control points can be
moved. Click a control point,
drag to a new location and the
Spline will update.
• Select Apply [7] to apply the
spline trace.
• Use File > Save Object Map to
save your work.
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Smart Trace
The Smart Trace tool detects regions
of high rate of change of voxel
intensity (gradient) representing
edges. The tool snaps to the edges
of these regions. The sensitivity of the
smart edge can be adjusted using the
slider or the mouse scroll wheel.
The following options are available:
Sensitivity: The sensitivity of the
smart edge can be adjusted using the
slider or the mouse scroll wheel. The
lower the value the less sensitive the
tool is, the higher the value the more
sensitive the tool is.
Reset Smart Trace after Apply:
Resets (deletes) the smart trace after
the region is defined. Smart trace
regions are defined after the user
double-clicks to close and end the
tracing process and then pressing the
Apply button, selecting the ‘A’ key
on your keyboard, or having the Auto
Apply option selected.
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Smart Trace Options
Auto Apply: When selected automatically applies the Smart Trace region.
Lock Control Points: Allows users to lock or unlock (default) the smart trace controls points. Unlocking the control points allows users to move
the control points.
Auto Advance: The auto advance option automatically moves users to a new slice, as defined by the auto advance options, once the current
edit is defined. Note the auto advance will occur after the user releases the left mouse button and the edit is applied to the current slice. The
auto advance option is a productivity tool allowing users to move through the image data without having to move the cursor from the current
orientation window that regions are being defined on. The following options are available.
•

Off: Off is the default option for auto advance. When off is selected auto advance is disabled.

•

Forward: Specifies that auto advance will move forward through the image data (slice number increases).

•

Backwards: Specifies that auto advance will move backwards through the image data (slice number decreases).

•

Increment: Specifies the number of slices the auto advance will move forward or backwards.

Right click options: Right clicking on the Smart Trace provides users with the following options:
•

Apply: Applies the trace.

•

Cancel: Cancels the trace, deleting the trace and controls points.

•

Auto Apply on Control Point Adjust: This option is only available when Auto Apply is enabled and when editing a Smart Trace or trace
converted to a Smart Trace. When selected any edits made to the Smart Trace will be automatically applied when a control point is
moved.

•

Delete Control Point: Deletes the control point the cursor if currently over.

•

Delete Spline: Deletes the trace and controls points.

Note: Clicking on an object border when the Smart Trace is selected will convert the object region into a Smart trace with adaptable control
points.
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Smart Trace Region Definition
To follow along, download the
data set MRI_3D_Head from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Select Manual [1] and choose
Smart Trace. [2].
• Left-click in the image to set the
first control point [3].
• Move the cursor along the edge
of the object and click to set
additional control points [4]. To
adjust the sensitivity of the smart
edge, use the mouse scroll wheel.
Scrolling up will increase the
sensitivity and scrolling down will
decrease sensitivity.
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Smart Trace Region Definition (continued)
• When the trace is complete,
double-click to close the spline [5].
• If needed, control points can
be moved. Uncheck the Lock
Control Points option, click on
a control point and drag it to a
new location. The Smart Trace
will update.
• Control points can be deleted.
Select a control point, right-click
and select Delete Control Point.
• Select Apply or use the A key to
apply the trace.
• Use File > Save Object Map to
save your work.
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Reassign Object
The Reassign Object tool allows users to interactively reassign the voxels of one object to another object. First, select the object to which
the voxels will be reassigned from the object control window. Then, select a reassignment type. Finally, to establish a seed pixel, click on the
object to be reassigned. Object reassignment occurs immediately. Reassignment options are described in the table below:

Reassignment Types
Reassignment Type

Action

All

All voxels in the selected object are reassigned to the current object

3D

All voxels in the selected object that are connected in 3D to the seed pixel are reassigned to the current object

2D

All voxels in the selected object that are connected in 2D to the seed pixel are reassigned to the current object

Unconnected 3D

All voxels in the selected object that are not connected in 3D to the seed pixel are reassigned to the current object
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Reassigning Objects
Here we will reassign the voxels of
one object to another object.
To follow along, download the
data set MRI_3D_Head from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Use File > Load Object Map to load
the corresponding object map.
• Select Manual [1] and choose
Reassign Object [2].
• Set the primary display to axial [3]
and move to axial slice 130.
• Switch the display of the Skin
object off and switch on the
display of the Lenticular and
Caudate objects. Select the Brain
object and change the Opacity
level of the Brain to 2 [4].
• Set the reassignment type to
All [5] and click on the yellow
Lenticular object [6].
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Reassigning Objects (continued)
•

Note that all the voxels of the
Lenticular object have been
reassigned to the Brain object [7].

•

Set the reassignment type to
3D [8] and click on the brown
Caudate object on the right side
of the brain [9].
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Reassigning Objects (continued)
•

Note that the all the voxels of the
Caudate object connected to the
seed pixel have been reassigned
to the Brain object [10]. As the left
caudate nucleus is not connected
to the right caudate nucleus, that
part of the object remains [11].

• Click Undo [12] and set
the reassignment type to
Unconnected 3D [13].
• Click on the brown Caudate
object on the right side of the
brain [14].
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Reassigning Objects (continued)
•

Note that this time, all the voxels
assigned to the Caudate object
connected to the seed pixel
have been kept [15] while those
unconnected voxels representing
the left caudate nucleus have been
reassigned to the Brain object [16].

•

Note that for the All, 3D and
Unconnected 3D reassignment
types, seed points can be set on
the 3D rendering.
• Set the reassignment type to
2D [17] and click on the anterior
section of the green Ventricle
object [18].
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Reassigning Objects (continued)
The voxels assigned to the Ventricle object, which are connected to the seed pixel only on this 2D slice have been reassigned to the
Brain object [19].
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Nudge Edit
Nudge Edit enables users to manually
edit borders of defined regions. The
tool allows object borders to be
pushed inwards or outwards using an
adjustable circular cursor. The size of
the cursor can be adjusted using the
middle mouse button. When Nudge
Edit is selected the cursor mode will
update to the Nudge Edit tool when
an image is clicked on. Available
options include:
Auto Advance: This option
automatically moves users to a new
slice as defined by the auto advance
options, once the current edit is
defined. Note the auto advance will occur after the user releases the left mouse button and the edit is applied to the current slice. The auto
advance option is a productivity tool allowing users to move through the image data without having to move the cursor from the current
orientation window that regions are being defined on. The following options are available.
•

Off: Off is the default option for auto advance. When off is selected auto advance is disabled.

•

Forward: Specifies that auto advance will move forward through the image data (slice number increases).

•

Backwards: Specifies that auto advance will move backwards through the image data (slice number decreases).

•

Increment: Specifies the number of slices the auto advance will move forward or backwards.
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Editing Object Borders using Nudge Edit
To follow along, download the
data set MRI_3D_Head from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Select File > Load Object Maps
and load MRI_3D_Head.obj.
• Select Manual, [1] then choose
Nudge Edit [2].
• Set the primary display to Axial [3]
and move to Axial slice 132 [4].
• To edit the border of the Brain
and Ventricle objects click in the
brain. The circular nudge tool
cursor will appear [5].
Note the color of the cursor will match
the object being nudged.
• Move the cursor to edit the
border [6].
• The borders of the Brain and
Ventricle objects will be updated
as the cursor moves through [7].
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Editing Object Borders using Nudge Edit (continued)
• Click Undo.
• Using the middle mouse button,
change the size of the cursor
to 5, then click in the Ventricle
object [8]. Push the border of the
Ventricle object out to edit the
object boundary [9].

• The borders of the Brain and
Ventricle objects will be updated
as the cursor moves through [10].
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Using the Nudge Edit Tool with Locked Objects
The Nudge Edit Tool can also be used
in conjunction with locked objects.
When measuring the intracranial area
on a certain slice, after reassigning
the Ventricle object on this slice
to the Brain object using Reassign
Object, the Skin object can be locked
and the brain object pushed out
using the Nudge tool to the border of
the skin object.
• Use Reassign Object to reassign
the Ventricle object on Axial slice
132 to the Brain object.
• Lock the Skin object.
• Select the Nudge Edit tool.
• Click in the Brain [1] and move
the Nudge Edit tool into the
intracranial space [2] between the
Brain and Skin objects.
• Note that the Brain object will
be pushed into the intracranial
space but not into the locked
skin object [3].
• Continue moving the Nudge tool
through the intracranial space [4].
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Using the Nudge Edit Tool with Locked Objects (continued)
•

Note that if the cursor moves past
the Skin object into the Original
object, voxels in the Original
object can still be added to the
Brain object using the Nudge
Edit tool. To prevent this, lock the
Original object as well.

• Continue moving through the
intracranial space [5] to complete
the edit [6].
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Divide Regions
The Divide Regions tool allows users to divide objects into subdivisions based upon the division type selected. Users can choose between
Grid, Radial or Between Borders.

Divide Type Function
Grid

Example

Divides selected object into rectangles.
Specify: Controls how the object will be divided by specifying between Rows and Columns or Region Size.
Rows & Columns: specifies the number of rows and columns the object will be divided into.
Region Size: specifies the size (in pixels) of the rectangle that will be used to divide the object.

Radial

Radially divides selected object, splitting the object into pie wedges.
Divisions: specifies the number of divisions the structure will be split into.
Start Angle: specifies the starting angle of the first division.
End Angle: disabled by default., but when enabled, specifies the ending angle for the radial division.

Between Borders

Divides object into concentric shapes.
Divisions: specifies the number of concentric divisions the structure will be split into between borders. Enter
the number into the text entry box or use the arrow up/down keys to set number.
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Grid Division of an Object
Grid division can be useful for
subdividing structures into various
anatomical substructures. Here we will
perform a grid division of the corpus
callosum (CC) on the mid-sagittal slice
into its substructures.
To follow along, download
MRI_3D_Head from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the dataset and open
Segment.
• Set the primary display to Sagittal,
[1] move to the mid-sagittal slice
[2] and Zoom to the CC [3].
• Select Manual and use either
Smart Trace or Auto Trace to
define the CC on the mid-sagittal
slice [4].
• Select Divide Regions [5]. Set the
Divide Type to Grid [6].
• Set the Number of Rows to 1 and
Columns to 6 [7].
• Click in the CC [8].
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Grid Division of an Object (continued)
• The CC will be divided into 6
Subregions [9].
• Note that the Rostrum [10] will
need to be assigned to a separate
object. This can be achieved
using the 2D reassignment option
in the Reassign Object tool.
Objects can be given the correct
structural names (Splenium,
Isthmus, Posterior Midbody,
Anterior Midbody, Rostral Body,
Genu and Rostrum) using the
Object Control window.
• Use File > Save Object Map to
save your work.
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Radial Division of an Object
Like grid division, radial division of
objects can be useful for subdividing
structures into various substructures.
To follow along, download the
data set MRI_3D_Head from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select MRI_3D_Head and open
Segment.
• Select Manual [1] and choose
Auto Trace [2].
• Set the primary display to Axial
[3] and use Slice [4] to move to
axial slice 130.
• Set a seed pixel in the white
matter [5] and adjust the minimum
and maximum threshold values [6]
to define the brain. A min value
of 45 and max value of 125 works
well for this data set.
• Click Apply [7] to define the
brain.
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Radial Division of an Object (continued)
• Select the Divide Regions tool [8] and set the Divide Type to Radial [9].
• With Division set to 8, click anywhere in the brain to divide the object into 8 radial divisions [10].
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Dividing Regions Between Borders – Interpolating Between Objects
The Divide Regions Between Borders
division type allows users to create
a concentric set of objects. The tool
will divide the area between an inner
and outer border into the number of
regions specified by the user, which
is acheived by interpolating new
borders between the inner and outer
border.
To follow along, download the
data set MRI_3D_Head from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the dataset and open
Segment.
• Set the primary display to Sagittal [1] and use Slice [2] to move to sagittal slice 96.
• Select Manual [3], and choose Spline [4].
• Use the Spline tool to define a region of interest around the brain [5].
• Add a new object and define a region of interest around the ventricles [6].
• Select the Divide Regions tool [7] and set the Divide Type to Between Borders [8].
• Set the Divisions to 2 [9].
• Click anywhere in the brain between the red brain border and the green ventricle border [10].
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Dividing Regions Between Borders – Interpolating Between Objects (continued)
• 2 new regions will be interpolated
between the brain and ventricles
[11].
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Dividing Regions Between Borders – Interpolating Within an Object
If there is no inner border defined
when using the Divide Objects
Between Border division type, the
tool will calculate the center of the
object and use this as an interpolation
point, creating new interior object
borders from the outer border.
• Select MRI_3D_Head and open
Segment.
• Set the primary display to
Sagittal [1] and use Slice [2] to
move to sagittal slice 96.
• Select Manual [3] and choose
Spline [4].
• Use the Spline tool to define a
region of interest around the
brain [5].
• Select the Divide regions tool
[6] and set the Divide Type to
Between Borders [7].
• Set the Divisions to 2 [8]. Click
anywhere in the brain [9].
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Dividing Regions Between Borders – Interpolating Within an Object (continued)
• The tool will detect that there
is no interior border and return
a Border Divide Error. Click OK
[10] to enable the tool to use the
center of the outside border as an
interpolation point to substitute
the interior border.
• The object will be subdivided
into regions interpolated from the
outer border and the new regions
will look like smaller versions of
the outer border [11].
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Adjust Regions
The Adjust Regions tool allows users to interactively manipulate regions. Users can rotate, translate, scale and deform objects. The adjust
option provides users with the following region adjustment options:

Adjust Regions Methods and Functions
Method

Function

Rotate

The Rotate option allows users to rotate a region. To rotate a region, left click on the region to select it, the region will be outlined with a dashed
yellow and red line. With the left mouse button still pressed move the mouse up to rotate the region clockwise and down to rotate counterclockwise.

Translate

The Translate option allows users to translate a region left, right, up, or down. To translate a region, left click on the region to select it, the region will
be outlined with a dashed yellow and red line. With the left mouse button still pressed move the mouse up, down, left, or right to move the region.
The following options are also available for translate:
With mouse movement: This is the default option and will allow the user to translate the selected region.
A copy of the region: Allows users to translate a copy of the selected region. Choose from the following Copied Object options
Same: Copied object is assigned to the same object as the selected object.
Current: Copied object is assigned to the currently selected object from the object list.
New: Copied object is assigned to a new object.
Region so that its centered on brightest point: This option will shift the selected region so that the brightest pixel in the object is used as the new
center point for the object.

Scale

The Scale option allows users to adjust the regions scale by increasing and decreasing it both horizontally and vertically. To scale a region, left click on
the region to select it, the region will be outlined with a dashed yellow and red line. With the left mouse button still pressed move the mouse up and
down to adjust the scale vertically or move the mouse left or right to adjust the scale horizontally.

Deform

The Deform option allows users to interactively deform regions. To apply a free transform deformation on a region, left click on the region to select it,
the region will be outlined with a dashed yellow and red line. With the left mouse button still pressed move the mouse up or down and left or right to
deform.
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Using the Adjust Regions tool
Here we will rotate, translate, scale
and deform objects using the Adjust
Regions tool.
To follow along, download the
data set MRI_3D_Head from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the dataset and open
Segment.
• Select File > Load Object Maps
and load MRI_3D_Head.obj.
• Set the primary display to Axial [1]
and move to Axial slice 136 [2].
• Select Manual [3] and choose
Adjust Regions [4].
• Set the Adjust Method to Rotate
[5].
• Click in an object to select it and
move the mouse up or down to
rotate the object [6].
• Release the mouse button to
end the rotation and commit the
rotation to the object [7].
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Using the Adjust Regions tool (continued)
• Click Undo [8] and set the Adjust
Method to Translate [9].
• With the Translate option set to
with mouse movement [10], click
in an object and drag to a new
location [11].
• Release the mouse button to end
the translation. The object will be
moved to the new location [12].
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Using the Adjust Regions tool (continued)
• Setting the Translate option to ‘a
copy of the region’ will allow you to
make a copy of the selected object
and move to a new location.
• Setting Copied Object to Same
assigns voxels in the new region
to the same object as the parent
region [13].

• Setting Copied Object to Current
assigns voxels in the new region
to the object currently selected
in the Object Control window
[14].
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Using the Adjust Regions tool (continued)
• Setting Copied Object to New
assigns voxels in the new region
to a new object [15].

The Translate Adjust Method also
allows users to Translate the region
so that it is centered on the brightest
point. With this option, the tool
calculates the brightest pixel in the
object and sets that as the the center
of the object, translating the object
appropriately.
• Set the Translate method to the
region so that it is centered on
the brightest point [16].
• Click in an object [17].
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Using the Adjust Regions tool (continued)
• The region will instantly be
recentered around the brightest
point in the object [18].
• Click Undo.
• Set the Adjust Method to Scale
[19].
• Click in an object and move your
mouse to increase the scale of
the selected object [21].
• Moving the mouse up and down
adjusts the scale in the vertical
direction. Moving the mouse
left and right adjusts the scale in
the horizontal direction. Moving
the mouse diagonally adjusts
the scale of the object while
preserving the shape. Release
the button to commit the scale
manipulation to the object.
• Click in an object and then move
your mouse to decrease the scale
of the selected object [21].
• Release the button to commit the
scale manipulation to the object.
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Using the Adjust Regions tool (continued)
• Undo the previous manipulations.
• Set the Adjust Method to
Deform [22].
• Click in an object and move
your mouse to experiment with
the deformations available [23].
In this example the user is
deforming the border of the
brain object.
• Releasing the mouse button
will apply the deformation to
the object.
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Fabricate Shape(s)
The Fabricate Shape(s) tool allows
users to create 2D and 3D objects
in the object map or input grayscale
data. The tool provides options for
users to create shapes interactively
or by loading a list of coordinates
defined in a text file.
The Object to Create option allow
users to specify a set of parameters to
create 2D or 3D objects within a data
set.
Dimension: Allows users to choose to
create a 2D or 3D object.
2-D: The following Shape options are
available for 2D object creation:
Dot: The Dot option allows user to create a 1-pixel dot on any of the 2D images.
Square: The Square option allows users to create a 2D square on any of the 2D images.
Rectangle: The Rectangle option allows users to create a 2D rectangle on any of the 2D images.
Line: The Line option allows users to create a 2D line on any of the 2D images.
Circle: The Circle option allows users to create a 2D circle on any of the 2D images.
Oval: The Oval option allows users to create a 2D oval on any of the 2D images.
Note the Filled option allows users to enable (default) or disable the application of a fill to the preview of the 2D region, the fill color will
correspond to the color of the selected object. Fill is not available for Dot or Line shape options.
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Fabricate Shape(s) Options
Draw Slice: The Draw Slice options provide the ability to specify the orientation and slice the shape will be created on. Alternatively, the
slice and orientation can be set by clicking on the desired slice in the desired orientation
·· 2-D Orient: Choose from Axial, Coronal, or Sagittal.
·· 2-D Slice: Use the slice slider or manually enter the slice number to create the object on for the selected orientation.

Location and Size: Provides the ability to specify the location and size of the shape being created. For any of the 2D shapes chosen (Dot,
Square, Rectangle, Line, Circle, or Oval), the following shape dependent sub-options are enabled:

Dot Location and Size Options:
·· Alt: Set the preferred way to define the size and location of the dot object.  Press Alt to choose; pixels (default), real world distances, or
X,Y coordinates (X,Y).  
·· X: Set the X location for the dot. Use the slider to set the value or manually enter the in the text entry box.
·· Y: Set the Y location for the dot. Use the slider to set the value or manually enter the in the text entry box.
Square Location and Size Options:
·· Alt: Set the preferred way to define the size and location of the square object. Press Alt to choose; pixels (default), real world distances,
manually setting the X, Y coordinates for the lower left corner, using sliders to set the X, Y coordinates for the lower left corner, or
manually setting the X, Y coordinates of the center of the square.
·· Center X: Set the X center location for the square. Use the slider to set the value or manually enter the in the text entry box.
·· Center Y: Set the Y center location for the square. Use the slider to set the value or manually enter the in the text entry box.
·· Size: Set the size in pixels for the square. Use the slider to set the value or manually enter the in the text entry box. Alternatively, click
on the square on the image and drag it to the desired size.
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Fabricate Shape(s) Options (continued)
Object to Create > 2D > Location and Size (continued):
Rectangle Location and Size Options:
·· Alt: Set the preferred way to define the size and location of the rectangle object. Press Alt to choose; pixels (default), real world
distances, manually setting the lower left (X1, Y1) and upper right (X2, Y2) coordinates, using sliders to set X1, Y1, X2, and Y2, doubleended slides to specify the both the X and Y low and high values, or manually entering the lower left rectangle X and Y coordinates
and the rectangle Width and Height values.
·· Center X: Set the X center location for the rectangle. Use the slider to set the value or manually enter the in the text entry box.
·· Center Y: Set the Y center location for the rectangle. Use the slider to set the value or manually enter the in the text entry box.
·· Width: Set the width in pixels for the rectangle. Use the slider to set the value or manually enter the in the text entry box. Alternatively,
select either vertical side of the rectangle on the image and drag it to the desired size.
·· Height: Set the height in pixels for the rectangle. Use the slider to set the value or manually enter the in the text entry box.
Alternatively, select either horizontal side of the rectangle on the image and drag it to the desired size.
Line Location and Size Options:
·· Alt: Set the preferred way to define the size and location of the line object. Press Alt to choose; setting start X, Y and end X, Y points
using sliders (default), double-ended sliders with pixel values, double-ended sliders with real world distances, or entering coordinates
manually.
·· Start X: Set the X start location for the line. Use the slider to set the value or manually enter the in the text entry box.
·· Start Y: Set the Y start location for the line. Use the slider to set the value or manually enter the in the text entry box.
·· End X: Set the X end location for the rectangle. Use the slider to set the value or manually enter the in the text entry box.
·· End Y: Set the Y end location for the rectangle. Use the slider to set the value or manually enter the in the text entry box.
·· Note, users can also manually adjust the end points of the line and drag to the desired location.
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Fabricate Shape(s) Options (continued)
Object to Create > 2D > Location and Size (continued):
Circle Location and Size Options:
·· Alt: Set the preferred way to define the size and location of the circle object. Press Alt to choose; pixels (default), real world distances,
or manually entering the center X, Y coordinates and circle radius.
·· Center X: Set the X center location for the circle. Use the slider to set the value or manually enter the in the text entry box.
·· Center Y: Set the Y center location for the circle. Use the slider to set the value or manually enter the in the text entry box.
·· Radius: Set the radius of the pixels for the circle. Use the slider to set the value or manually enter the in the text entry box.
Oval Location and Size Options:
·· Alt: Set the preferred way to define the size and location of the oval object. Press Alt to choose; pixels (default), real world distances,
manually entering the center X1, Y1 and X2, Y2 coordinates, using sliders to set the X1, Y1 and X2, Y2 coordinates, double-ended
sliders to set both X/Y high/low values, or manually entering the lower left X and Y coordinates and the oval Width and Height
·· Center X: Set the X center location for the oval. Use the slider to set the value or manually enter the in the text entry box.
·· Center Y: Set the Y center location for the oval. Use the slider to set the value or manually enter the in the text entry box.
·· Width: Set the width in pixels for the oval. Use the slider to set the value or manually enter the in the text entry box.
·· Height: Set the height in pixels for the oval. Use the slider to set the value or manually enter the in the text entry box.
··
3-D: The following Shape options are available for 3D object creation:
Dot: The Dot option allows user to create a 1-pixel dot within the volume data.
Cube: The Cube option allows users to create a 3D cube within the volume data.
Box: The Box option allows users to create a 3D box within the volume data.
Line: The Line option allows users to create a 3D line within the volume data.
Sphere: The Sphere option allows users to create a sphere within the volume data.
Ellipsoid: The Ellipsoid option allows users to create an ellipsoid within the volume data.
Cylinder: The Cylinder option allows users to create a cylinder within the volume data.
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Fabricate Shape(s) Options (continued)
Object to Create > 3D (continued):
Note the Filled option allows users to enable (default) or disable the application of a fill to the preview of the 3D region, the fill color will
correspond to the color of the selected object. Fill is not available for the Dot or Line shape options.
Location and Size: Provides the ability to specify the location and size of the shape being created. For any of the 3D shapes chosen (Dot,
Cube, Box, Line, Sphere, or Ellipsoid), the following shape dependent sub-options are enabled:
Dot Location and Size Options:
·· Alt: Set the preferred way to define the size and location of the dot object. Press Alt to choose; pixels (default), real world distances,
text file input (see Creating Objects from a Text File for further information), or manually entering the X,Y, Z coordinates (X, Y, Z).
·· X: Set the X location for the dot. Use the slider to set the value or manually enter the in the text entry box.
·· Y: Set the Y location for the dot. Use the slider to set the value or manually enter the in the text entry box.
·· Z: Set the Z location for the dot. Use the slider to set the value or manually enter the in the text entry box.
·· Note, users can click on any of the 2D images or the rendering to set the X, Y, Z coordinates for the dot.
Cube Location and Size Options:
·· Alt: Set the preferred way to define the size and location of the cube object. Press Alt to choose; manually entering X, Y, Z center
voxel coordinates and cube size (default), sliders to define the X, Y, Z, and size parameters of the cube, sliders with corresponding
real world distances, text file input, or manually setting the X, Y, Z coordinates for the lower left front corner coordinate and cube size
value.
·· Center (X, Y, Z): Set the cube center voxel by entering the X, Y, Z coordinates of the center location for the cube. Alternatively, click and
drag the 2D display of the cube in any orthogonal orientations to reposition.
·· Size: Set the size in voxels for the square. Users can also click on the 2D display of the cube in any orientation and interactively increase
or decrease the size of the cube in 3D.
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Fabricate Shape(s) Options (continued)
Object to Create > 3D > Location and Size (continued):
Box Location and Size Options:
·· Alt: Set the preferred way to define the size and location of the box object. Press Alt to choose; to use slides to enter X, Y, Z and Width,
Height and Depth values in voxels for the box (default), manually entering X, Y, Z center and the box Width, Height and Depth values,
using sliders to specify the X, Y, Z center values and Width, Height, and Depth values in real world coordinates, use a text file to specify
the box parameters, manually specify the X1, Y1, Z1 and X2, Y2, and Z2 values to define the box, use sliders to determine the X1, Y1, Z1
and X2, Y2, and Z2 values, use double-ended sliders the X, Y, and Z upper and lower parameters, or manually enter coordinates for LX,
LY, LZ and With, Height, and Depth values to define the box.
·· Left (X): Set the X value for the box. Use the slider to set the value or manually enter the in the text entry box.
·· Lower (Y): Set the Y value for the box. Use the slider to set the value or manually enter the in the text entry box.
·· Front (Z): Set the Z value for the box. Use the slider to set the value or manually enter the in the text entry box.
·· Width: Set the width value for the box. Use the slider to set the value or manually enter the in the text entry box.
·· Height: Set the height value for the box. Use the slider to set the value or manually enter the in the text entry box.
·· Depth: Set the depth value for the box. Use the slider to set the value or manually enter the in the text entry box.
Line Location and Size Options:
·· Alt: Set the preferred way to define the size and location of the line object. Press Alt to choose; setting start X, Y, Z points for the
line end points using double-ended slider bars, using double-ended slider bars mapped to real work distances, manually entering
the XYZ coordinates for both end points, or using single sliders to specify the Start X, Start Y, Start Z, End X, End Y, and End Z
coordinates.
·· X, Y, Z Sliders: Use the double-ended slider bar to set the X, Y and Z values for each end point of the 3D line. Adjusting the lower end
of the slider will adjust the X, Y or Z point location for the first end point of the line while adjusting the upper end of the slider will
adjust the X, Y or Z point location for the second end point of the line.
·· Note, line end point for the 3D line can be adjusted by selecting and moving the end points on any of the orthogonal images.
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Fabricate Shape(s) Options (continued)
Object to Create > 3D > Location and Size (continued):
Sphere Location and Size Options:
·· Alt: Set the preferred way to define the size and location of the sphere object. Press Alt to choose; to set sphere parameters in voxels
using an X, Y, Z and Radius slider (default), to set sphere parameters in real world distances using an X, Y, Z and Radius slider (default),
a text file to define a sphere(s), or manually enter the X, Y, Z and Radius parameters in voxels manually.
·· Center X: Set the X center location for the sphere. Use the slider to set the value or manually enter the in the text entry box.
·· Center Y: Set the Y center location for the sphere. Use the slider to set the value or manually enter the in the text entry box.
·· Radius: Set the radius of the pixels for the sphere. Use the slider to set the value or manually enter the in the text entry box.
Ellipsoid Location and Size Options:
·· Alt: Set the preferred way to define the size and location of the ellipsoid object. Press Alt to choose; to set ellipsoid parameters in
voxels (default), real world distances, using a text file, manually entering the center X1, Y1, Z1 and X2, Y2, Z2 coordinates, using sliders
to set the X1, Y1, Z1 and X2, Y2, Z2 coordinates, double-ended sliders to set both X, Y, and Z upper and lower values, or manually
entering the lower left X, Y, Z coordinates and the ellipsoid Width, Height, and Depth values, use sliders to enter the X, Y, Z position
information and Width, Height, and Depth values, or coordinates to specify the center X, Y, Z and values for ellipse Width, Height, and
Depth.
·· Center X: Set the X center location for the ellipsoid. Use the slider to set the value or manually enter the in the text entry box.
·· Center Y: Set the Y center location for the ellipsoid. Use the slider to set the value or manually enter the in the text entry box.
·· Center Z: Set the Z center location for the ellipsoid. Use the slider to set the value or manually enter the in the text entry box.
·· Width: Set the width in pixels for the ellipsoid. Use the slider to set the value or manually enter the in the text entry box.
·· Height: Set the height in pixels for the ellipsoid. Use the slider to set the value or manually enter the in the text entry box.
·· Depth: Set the depth in pixels for the ellipsoid. Use the slider to set the value or manually enter the in the text entry box.
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Fabricate Shape(s) Options (continued)
Object to Create > 3D > Location and Size (continued):
Cylinder Location and Size Options:
·· Alt: Set the preferred way to define the size and location of the cylinder object. Press Alt to choose; to set cylinder parameters in
voxels (default), use real world distances, to use a text file, to manually entering the center X, Y, Z coordinates and input the radius and
length values, or use sliders to input the Center X, Y, Z, Radius, and Length values.
·· Center X: Set the X center location for the cylinder. Use the slider to set the value or manually enter the in the text entry box.
·· Center Y: Set the Y center location for the cylinder. Use the slider to set the value or manually enter the in the text entry box.
·· Center Z: Set the Z center location for the cylinder. Use the slider to set the value or manually enter the in the text entry box.
·· Radius: Set the radius in pixels for the cylinder. Use the slider to set the value or manually enter the in the text entry box.
·· Length: Set the length in pixels for the cylinder. Use the slider to set the value or manually enter the in the text entry box.
·· Axis: Choose which axis; X, Y, or Z (default) to orientate the length of the cylinder.
Apply changes to: Allows users to select the image volume, the object map, or both to defined the fabricated shape(s).
Volume: Applies the fabricated object to the grayscale image data.
•

Set Volume Voxels to: Choose to assign greyscale voxel values as user defined Specified value, a Random Value, or a Gaussian Value.
·· Specified value: Allows users to select a greyscale value that all voxels within the fabricated shape will be assigned to.
·· Random Value: Assigns voxel values within the fabricated shape to editable random values from 1 to 255.
·· Gaussian Value: Assigns voxel values within the fabricated shape to a Gaussian Value. Default Mu and Sigma values are assigned at
128.0 and 25.6 respectively but can be updated by the user.

•

Object Map: Allows users to assign the fabricated shape to the selected object in the object list.

•

Both: Applies fabricated shape to both the Volume and Object Map (see above).

Create Shape: Initiates the Fabrication process.
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Using Fabricate Shape(s)
Here we will use the Fabricate
Shape(s) tool to create a 3D shape in
a volume.
To follow along, download the data
set CT_Foot from analyzedirect.com/
data and load into Analyze using
Input/Output.
• Select the data set and open
Segment.
• Select File > Load Object Maps
and load CT_Foot.obj.
• Select Manual [1] and choose
Fabricate Shape(s) [2].
• Set the Dimension to 3D [3] and
set the Shape to Sphere [4].
• Use the linked cursor to navigate
to the location where you would
like to create the new shape [5].
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Using Fabricate Shape(s) (continued)
• Add a new object, name it and
assign a color [6].
• Change the Radius of the sphere
[7] and drag the 2D shape
template in any of the images to
the location you where you want
to create the shape [8].
• Select Create Shape [9].

• The shape will be created and
added to the object map. Rightclick on the rendering and select
Transparency for a clearer view of
the object in 3D [10].
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Creating Objects from a Text File using Fabricate Shape(s)
Here we will show how Fabricate
Shape(s) can create objects defined in
a text file.
To follow along, download the
data set Trans_Pre_OP_MRI from
analyzedirect.com/data and load into
Analyze using Input/Output.
• Select the data set and open
Segment.
• Select File > Load Object Maps
and load Trans_Pre_OP_MRI_
brain.obj.
• Select Manual [1] and choose
Fabricate Shape(s) [2].
• Set the Dimension to 3D [3] and
set the Shape to Sphere [4].
• Add a new object, name it
Electrodes and assign a color to
the object [5].
• Click on the Alt button [6] and
select File.
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Creating Objects from a Text File using Fabricate Shape(s) (continued)
• In the window returned set Files
of type to Text File (*.txt) [7].
• Select Electrodes text file [8] and
click Open [9].

• Set the Radius to 6 [10] and click
Create Shape [11].
• Once created, the new shapes
will be added to the object map
and can be viewed overlaid on
the 2D images and in the 3D
rendering [12].
• Right-click on the rendering and
select Transparency for a clearer
view of the objects in 3D.
• Select File > Save Object Map
and save your object map as
Trans_Pre_OP_MRI_brain_and_
electrodes.obj.
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Manual Tools for 3D Editing
Some of the manual tools have the
capability to be used to edit objects
in 3D. This is achieved by drawing
directly on the 3D rendering.
To follow along, download the data
set CT_Foot from analyzedirect.com/
data and load into Analyze using
Input/Output.
• Select the data set and open
Segment.
• Set the primary display to
Render [1].
• Select Semi-Automatic [2] and
choose Threshold Volume [3].
• Set a Threshold range [4] to
isolate the bones of both feet
and click Threshold Object [5].
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Manual Tools for 3D Editing (continued)
• Select Manual [6] and choose
Manual Trace [7].
• Add a new object [8].
• Move the cursor to the Rendering
and trace around the right foot
[9].

• Complete the trace and release
the left mouse button. All voxels
not assigned to the Original
object within the trace will be
assigned to the selected object
[9].
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Manual Tools for 3D Editing (continued)
• Add a new object.
• Select the Freehand Draw trace
and trace over one of the bones
in the right foot [11].

• Everything under the region
will be assigned to the selected
object [12].
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Dual Input Segmentation
Segment allows users to load two
registered input data sets. The
ability to load related volumes is
powerful and allows users to segment
structures from either data set.
• Load registered pre-operative
MRI and post-operative CT.
• Segment the brain from the MRI
and electrodes from the CT.
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Dual Input Segmentation (continued)
• Load registered structural
MRI and functional PET data.
Structural regions can be
delineated on the MRI and
viewed on the PET, while regions
of activity or uptake can be
viewed on the functional data
and displayed on the MRI.

• Loading two copies of the same
input data set allows users to
adjust or invert intensity display
values on the related volume. This
can be leveraged to assist with the
segmentation of brain structures
such as the thalamus.
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4D Segmentation
Segment supports 4D multivolumes. Users can use all of the segmentation tools to derive 2D, 3D, or 4D regions of interest. Segmentation
using many of the Semi-Automatic tools can be configured to automatically propagate to the next 3D volume in the 4D multivolume as soon
as the first segmentation is complete. To follow along, download the multivolume data set Cardiac_Cycle_CT from analyzedirect.com/data
and load into Analyze using Input/Output.
• Select the multivolume data set and open
Segment.
• A Volume control window will be available
above the object control window [1].
• The slider [2] allows users to navigate
through the 3D volumes in the multivolume.
• The window also provides the user with
options to create a 3D or 4D object map
[3] and to enable or disable the currently
selected semi-automatic segmentation
tool to be applied to all volumes in the
multivolume [4].
• Select Semi-Automatic [5] and choose
Region Grow [6].
• Set a seed point in a blood pool [7] and set
a threshold range to isolate the object of
interest [8].
• Confirm mode is set to 4D and the Grow
All Volumes option is checked [9]. Click
Connect Object [10].
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4D Segmentation (continued)
Segment will isolate the object from
the first volume of the multivolume.
After segmentation is complete, the
parameters used to isolate the object
from the first volume will be copied to
the next volume and the blood pool
will be segmented on the second
volume. This will continue until all
volumes have been processed. Use
the volume slider to navigate through
the multivolume to review the
segmentation results.
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Generating Surface Files from Objects
Surface generation offers users
the ability to create and export
surface files for 3D printing, additive
manufacturing, and CAD applications.
There is a fundamental transformation
that needs to take place between the
voxel-based volume image world and
an explicit surface description file,
for which Analyze provides several
helpful algorithms.

Analyze provides the ability to
efficiently and accurately extract and
represent a surface from a specific

Format

Extension

Alias Wavefront

.obj

Autocad

.dxf

Compressed IGES

.iges

IGES

.iges

Inventor

.iv

Patran

.out

object of interest, exporting this

Ply

.ply

surface in several common surface

Poly

.poly

description formats including STL (see

3D Systems

.stl

table for a list of supported surface

Binary 3D Systems (default)

.stl

formats).

VRML

.wrl

The key to surface generation is to use Analyze to accomplish a segmentation of the particular structure of interest from the volume image
data, using any of the available tools provided with Segment, and then use the segmented object to drive the surface extraction process for
the optimal definition and output of the surface data.
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Surface Generation Options
The Segment module provides the mechanism to extract a surface description of segmented
objects from volume image data via two unique Analyze-specific algorithms; Adapt Deform or
Marching Cubes. Both Adapt Deform and Marching Cubes extract an optimal description of
the surface with as few polygons as possible. Once extracted, the surface can be saved in many
common surface description formats and imported into third party 3D printing program, CAD
software, or rapid prototyping equipment.
Extract Surface: The Extract Surface window provides users with the interface to generate
surface files. To access the window right click in the Object List and choose Extract Surface [1].
The following options are available:
•

Object: The Object selection area allows users to select objects to generate surfaces
for [2]. Note that multiple objects can be selected, each object will be exported to its
own surface file. If users wish to combine objects in a single surface file objects either
need to be combined prior to surface extraction using the Reassign Object function
or combination needs to be conducted after export using a third-party application.

•

Filename: Surface file names are specified in the Filename field. [3] This field
becomes available once an object is selected.

•

Options: The Options area allows users to specify the surface extraction method
for surface generation. When a method is selected method specific options become
available. User can choose between Adapt Deform and Marching Cubes:
·· Adapt Deform: The Adapt Deform algorithm (enabled by default) [4] specifies
that the adaptive deformation algorithm will be used to generate the tiled
surface.
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Surface Generation Options (continued)
•

Options (continued)
·· Adapt Deform (continued): This algorithm is based on an adaptive mesh model; a discrete dynamic system constructed from a set
of nodal masses that are interconnected by adjustable springs. This system is governed by a set of ordinary differential equations of
motion (discrete Lagrange equations) that allow the system to evolve to equilibrium.
In the mass-spring model, the set of coupled equations are solved iteratively in time to update the position of the nodal masses until
the masses reach an equilibrium position. For the purposes of surface reconstruction, the equilibrium positions of the nodal masses
will approximate the surface of the object. The initial positions of the nodal masses are determined by creating a rough approximation
of the surface using a surface tracking technique. A cubic grouping element is used to create a lower resolution version of the data
set, which is then systematically triangulated to form the initial approximation of the surface. The following options are available:
·· Specify Budget: Allows users to specify the maximum number of polygons in the final surface.
·· Iterations: Iterations allows the user to specify the number of iterations of the
deformation process. While there are a maximum number of iterations beyond
which there will be little or no improvement in the quality of the final surface, that
point is highly dependent on the data.
·· Cube Edge Size: The Cube Edge Size option allows users to adjust the length (in
voxels) of a side the initial cubic grouping element. This grouping element is used
to form the initial surface approximation. If the polygonal budget is set to 0, then
smaller cubes will result in higher resolution surfaces, otherwise cube size should
be inversely related to the polygonal budget in order to reduce the number of
iterations required to reach equilibrium (small polygonal budgets require large
cube sizes).
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Surface Generation Options (continued)
•

Options (continued)
·· Adapt Deform (continued):
The effects of changing the
cube edge size on the resulting
surface can be seen in this
image. The larger the cube
edge size the smoother the
generated surface is. Note,
increasing the resolution
(reducing cube edge size)
increases the processing time
and this is demonstrated by
setting the ‘Cube Edge Size’ to
‘1’.
·· In cases where a high resolution (Cube Edge Size of 1) is required, it is
recommended that users use the Marching Cubes algorithm.
·· Marching Cubes: The Marching Cubes option [5] specifies that the marching
cubes algorithm will be used to generate the tiled surface. The algorithm
processes the data in scan line order and calculates the polygonal vertices using
linear interpolation.
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Surface Generation Options (continued)
•

Options (continued)
·· Marching Cubes (continued): As
discussed in Adapt Deform if a surface
file of the exact segmented object
(a cube edge size of 1) is required,
then Marching Cubes should be
used. This will provide an accurate
surface description, in a smaller file,
in a fraction of the time of Adapt
Deform.
·· Use Gradient: The Use Gradient
option is enabled (checked) by
default.
·· Checked: When enabled the algorithm will use the gradient information present in the voxel data to estimate surface position. This
results in a smooth surface that may have a higher error estimate than the equivalent binary surface extraction.
·· Unchecked: When enabled the algorithm will ignore gradient information and generate a surface based on binary thresholding. This
will produce a “voxelated” surface that minimizes the error between voxel surface and the reconstructed polygonal surface.
·· Output Scaled Data: When selected will scale the surface file into real world coordinates. When the surface coordinates will be scaled
from voxel dimensions in the header information of the data to real world dimensions. This requires the VoxelWidth, VoxelHeight, and
VoxelDepth parameters be set correctly in the volume’s header information.
·· Output Directory: Allows users to specify the location where the generated surface files will be saved to.
·· Output Format: Allows users to specify the format the generated surface files will be saved in (see previous table for formats)
·· Right-handed: For both the Adapt Deform and Marching Cubes extraction processes the surface files created will have a 3D lefthanded coordinate system. Checking the right-handed option will flip the surface file to a right-handed coordinate system.
·· Extract Surface(s): Initiates the surface generation and export routine. When completed a dialog box will be returned.
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Generating Surface Files from a Selection of Objects
Here we will generate several surface files at once from objects we have previously segmented
and which are contained in an object map.
To follow along, download the data set MRI_3D_Head from analyzedirect.com/data and load
into Analyze using Input/Output.

• Select the data set and open Segment.
• Select File > Load Object Maps and load MRI_3D_Head.obj.
• Right click on the object list [1] and select Extract Surface [2].
• Select the objects that you will use to generate a surface file [3].
• The output surface name will be the same as the object name. If desired, rename the output
surface file name [4].
• Select the surface generation method [5].
• Set the Output Directory [6].
• Choose the ouput format [7].
• Click Extract Surface(s) [8].
• When surface generation is complete a notification will be returned confirming that the
selected surfaces have been generated and saved. Click OK [9] to close the window.

The generated surfaces can now be retrieved from the output directory and used in other third
party applications such as 3D printing, additive manufacturing, or computer aided design.
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